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For Detailed information go to the Help Menu in Adobe Acrobat.

Opening PDF documents
The documents on this site open with page one and Bookmarks opened on the left pane for easy
navigating to whatever page you would like to view.

We do not default to Full Screen View, however if a document is set to open in Full Screen view,
the tool bar, menu bar, and window controls are not visible. You can exit Full Screen view by
pressing Escape, if your preferences are set this way, or by pressing Ctrl+L (Microsoft®
Windows® and UNIX®) or Command+L (Mac OS).

Viewing PDF documents on the Web

With most of the files at this site, you can view PDF documents using a Web browser. Every
document on the Web is identified by a (URL). When a PDF document is stored on the Web, you
can click a URL link to it to open the PDF document in your

Web browser. This is the preferred method.

Reading PDF documents in a Web browser

In Win and Mac OS, PDF documents are displayed in the Web browsers compatible with
Netscape Navigator 4.0 (or later) or Microsoft Internet Explorer 4.0 (or later).

Normally the necessary plug-ins are automatically installed when you install Acrobat Reader. For
information on manually getting your browser ready, see Installing the Web browser plug-in.

(NOTE: If pages of your PDF document appear blank when viewed in a Web browser, you may
be using an early version of a Web server. Try saving the PDF file locally, and viewing it using
Acrobat Reader instead of the plugin.)

When you view a PDF document in a Web browser, all of the Acrobat Reader tools are available
in the browser. In Windows, you can click the two small vertical lines (next to the Adobe icon at
the left of the tool bar) to minimize or maximize the tool bar.

Note: Many keyboard commands are mapped to the Web browser rather than to Acrobat Reader,
so some Acrobat Reader keyboard shortcuts may not be available in the browser window.

In UNIX, PDF documents can display in Web browsers compatible with Netscape
Navigator 4.0 (or later) only. To set up Netscape compatibility, launch Netscape using the
Netscape script located in the Acrobat 4.0/Browsers directory. Follow the instructions in the
INSTGUIDE.TXT file to link your Netscape browser to the Acrobat 4.0 Reader with Search
application.

Web viewing scenarios

Here are four possible scenarios for viewing PDF on the Web. We use Optimized PDF files to
download a page-at-time This is when the browser supports PDF viewing, the PDF file is
optimized, and the Web server supports page-at-a-time downloading (byte-serving), so the PDF
file downloads a page at a time and displays the file pages in the Web browser window. This is
the fastest scenario possible for viewing PDF documents on the Web.



There are other downloading possibilities, which we do not use on this site.

Page-at-a-time downloading

With page-at-a-time downloading (byte-serving), the Web server sends only the requested
page of information to the user, not the entire PDF document.

For those who want the entire document, there are other methods used to download the entire
document to your hard disk.

As a reader of the PDF document, you do not have to do anything to make this page-at-a-time
happen; it is communicated in the background between Acrobat Reader and the Web server. If
you want the entire PDF document to continue downloading

in the background while you view the first page of requested information, be sure Allow
Background Downloading is selected in the General preferences dialog box (default).

If you wish to download the entire file to your computer, right click your mouse button, and then,
Select: Save link as... If you use Netscape or,

Select: Save target as... If you use Internet Explorer

After you decide where on your computer you want the file, hit "'SAVE'"' to
download. Once the file is on your computer double click on it to open it in Acrobat
Reader. With this method you can open these files from your computer at anytime.

Reading PDF in a Web browser

PDF documents can display in Web browsers compatible with Netscape Navigator 3.0 (or later)
or Internet Explorer 3.0 (or later). The necessary plug-ins are automatically installed when you
install Acrobat Reader.

When you view a PDF document in a Web browser, all of the Acrobat Reader tools are available
in the browser. In Windows, you can click the two small vertical lines (next to the Adobe icon at

the left of the toolbar) to minimize or maximize the toolbar.

Note: Many keyboard commands are mapped to the Web browser rather than to Acrobat Reader,
so some Acrobat Reader keyboard shortcuts may not be available in the browser window.

Installing the Web browser plug-in

Browsers compatible with Netscape Navigator need the nppdf32.dil file (Windows), the nppdf.so
file (UNIX), or PDFViewer plug-in (Mac OS) to display PDF.



When you install Acrobat Reader with Search, this plug-in is automatically installed in the
Netscape plug-in folder (Win and Mac OS), if you have Navigator on your system. If you install
Navigator after installing Acrobat Reader, or if you’re using another browser compatible with
Navigator, you can install this plug-in yourself. To set up Netscape Navigator on a UNIX system,
you must run the Netscape launch script located in the Browser folder.

To manually install the Web browser plug-in (Windows):
1 Open the Browser folder in the Acrobat Reader folder.
2 Copy the nppdf32.dll file to your Web browser’s plug-ins folder.

To manually install the Web browser plug-in (Mac OS):
1 Open the Web Browser Plug-in folder in the Acrobat Reader folder.
2 Copy the PDFViewer plug-in to your Web browser’s plug-ins folder.

To open a PDF document that’s been downloaded onto your system:
Do one of the following:

Click the Open button , or choose File > Open. In the Open dialog box, select the filename for
the file downloaded on your computer, and click Open. PDF documents usually have the
extension .pdf.

You can also choose the document’s filename from the File menu for the last four PDF
documents you opened. You can also Double-click the file icon in your file system.

Note: In Mac OS, you may not be able to open a PDF document created in Windows by double-
clicking the icon. If double-clicking the icon in Mac OS does not open the document, use File >
Open in Acrobat Reader to open the document, close the document, and try again. After you've
used the Open command once on the document, you’ll be able to open the document next time by
double-clicking.

To display a list of all Acrobat Reader command-line options (UNIX), start the Acrobat Reader
product with the -help option. For example: acroread -help

To manually install the Web browser plug-in (UNIX):
Run <installdir>/Browsers/netscape.

Browsing with bookmarks

Bookmarks mark parts of a document for quick access, link to page views in other documents,
link to the Web, play a movie or sound, enter an article, or reset or submit a form. Primarily we
are concerned with the sheet music at present however as this develops more features will be
incorporated. Essentially Bookmarks are nothing more than links to open pages inside the
document or files outside of the document.

To browse with a bookmark:
1 Show the Bookmarks palette (This is the default on first opening the music files. If not, you

may need to choose Window > Show Bookmarks to open the palette or click the Bookmarks tab
to bring the palette to the front of its group.



2 To jump to a topic using its bookmark, click the bookmark’s icon or text in the palette.

Note: Clicking a bookmark might perform an action, such as playing a movie, instead of taking
you to another location. It depends on how the bookmark was defined.

The bookmark for the part of the document currently showing appears boldfaced. If the
navigation pane disappears when you click a bookmark, the document creator has activated the
Hide After Use command. To show the navigation pane again, click the Show Navigation Pane
button on the command bar. Deselect Hide After Use in the navigation pane’s palette menu if you
want the navigation pane to remain open after you click a bookmark.

Bookmarks can be subordinate to other bookmarks in their hierarchy; a higher-level bookmark in
this relationship is the parent, and a lower-level bookmark is the child. You open these and close
these by selecting the (+) to open or (-) to close next to the bookmark listing if in Windows and
the Triangle in the MacOS.

In other words, you can collapse a parent bookmark in the palette to hide all its children. When a
parent bookmark is collapsed, it has a plus sign (Windows) or a triangle (Mac OS) next to it. If
the bookmark you want to click is hidden in a collapsed parent, click the plus sign or triangle next
to the parent to show it.

Paging through a document

Acrobat Reader provides buttons, keyboard shortcuts, and menu commands for paging through
PDF documents.

To go to another page do one of the following:

To go to the next page, click the Next Page button in the command bar or status bar, press the
Right Arrow key, press Ctrl (Windows or UNIX) or Option (Mac OS) and the Down Arrow key,
or choose Document > Next Page.

To go to the previous page, click the Previous Page button in the command bar or status bar,
press the Left Arrow key, press Ctrl (Windows or UNIX) or Option (Mac OS) and the Up Arrow
key, or choose Document > Previous Page.

To move down one line, press the Down Arrow key.
To move up one line, press the Up Arrow key.

Note: The Down and Up Arrow keys move you one line at a time when you are in Window view.
In Single Page mode, these keys move you one page at a time if the page fills the entire screen.

To move down one screen, press Page Down or Return.
To move up one screen, press Page Up or Shift+Return.

To go to the first page, click the First Page button in the command bar or status bar, press the
Home key, or choose Document > First Page.



To go to the last page, click the Last Page button in the command bar or the status bar, press the
End key, or choose Document > Last Page.

To jump to a page by its number:
Do one of the following:

Select the current page number in the status bar, type the page number to jump to, and press
Return.

Choose Document > Go To Page, type the page number, and click OK.

OR

Drag the vertical scroll bar until the number of the page you want to jump to is displayed.
To retrace your viewing path:

To retrace your path within a PDF document, click the Go to Previous Viewbutton in the
command bar, or choose Document > Go Back for each step back. Or click the Go to Next View
button, or choose Document > Go Forward for each step forward.

To retrace your viewing path through other PDF documents, choose Document > Go Back Doc
for each step back or Document > Go Forward Doc for each step forward. Or hold down Shifft,
and click the Go Back or Go Forward button. This command opens the other PDF documents if
the documents are closed.

Visiting the Adobe Web site For additional help:

Click the Adobe Web Site button to link directly to the Adobe Web site (www.adobe.com). This
page contains valuable information about new technology, links to Acrobat plug-ins, and more.
On the Adobe Web site home page, you can click a country name in the Adobe Sites pop-up
menu to choose a language for viewing the site. The exact information in the site may vary from
one language version to another.



ASATHOMA

(FROM UNTRUTH LEAD ME TO THE TRUTH)

Transcribed from a recording of BHAGAVAN SRI SATHYA SAI BABA singing this mantra.
English text adapted from various translations by Dennis Neal, USA.

[
AN N I fr— N ) E——
L i ] - ] ] ) 7
G+ s—s 3 ——
A-sa-tho—_- Maa_—____  Sad Ga-ma - ya_
From un-truth__lead_—________  me (us) to the truth,—______
S = £
—
[a) A A | ; \ |
S | | A :
o 7
o ——3 2 — —
Tha - ma - so Maa______  Jyo_ - thir Ga- ma- ya
From__ dark— - ness— lead— me(us) to the light__—_
rax e & . el
2 : |
I T
O T f I — N R m | R A
V4t ]1;‘ | I' I) ‘(, I) / ]
" — ’ 5 2 =
D) &
Mrith_- yor Maa Am-ri-tam Ga- ma- ya
From__ death___ lead— me(us)to im-mor - tal - i- ty.
or—8 e . —
e o ; o e
L | | | Ir/
*OpRional | |
- T Y T ry T [r—
i | ——— e e |
Saa & i b 33
om,— Shan__ ti, Shan_— - ti, Shan_—_- ti.
Om,_—___  Peace, Peace, Peace
&) f f i
T I T I T I

This Mantra is comprised of three prayers.

1. "O Lord, when | am deriving happiness through the objects of
this world, make me forget the unreal objects and show me the way

to permament happiness.”

2. "O Lord, when the objects of this world attract me, remove the
darkness which hides the all-pervading Atma, which every such

object really is.”

3."O Lord, bless me through Your Grace with Immortality, or
Paramananda, resulting from the awareness of the effulgence of the

Atma, immament in every object."

This is the real meaning of the Manthra.

(Portions of a quotation of Bhagavan Sri Sathya Sai Baba, appearing in the
book, DIGEST, which is a collection of His sayings.)

Copyright - All Rights Reserved. Permission Granted for Non-Commercial Use for the Purpose of Photo-

copying the Music for Personal or Group Devotional Singing. Recording Rights or Mass Redistribution

Rights are Not Granted for Commercial or Non-Commercial Use. Contact the Owner of the Copyright for
Permission. The Web Site Will Not Grant Permission for Any Other Use Held by the Owner of the

Copyright.



Transcribed from a recording of BHAGAVAN
SRI SATHYA SAI BABA singing this mantra.

ASATHOMA

(FROM UNTRUTH LEAD ME TO THE TRUTH)

English text adapted from several
translations by Dennis Neal, USA.
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Oom,___ Peace, Peace, Peace

This Mantra is comprised of three prayers.

1. "O Lord, when I am deriving happiness through the objects of
this world, make me forget the unreal objects and show me the way
to permament happiness.”

2. "0 Lord, when the objects of this world attract me, remove the
darkness which hides the all-pervading Atma, which every such
object really is."

3."O Lord, bless me through Your Grace with Immortality, or
Paramananda, resulting from the awareness of the effulgence of the
Atma, immament in every object."

This is the real meaning of the Manthra.

(Portions of a quotation of Bhagavan Sri Sathya Sai Baba, appearing in
the book, DIGEST, which is a collection of His sayings.)
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copying the Music for Personal or Group Devotional Singing. Recording Rights or Mass Redistribution
Rights are Not Granted for Commercial or Non-Commercial Use. Contact the Owner of the Copyright for
Permission. The Web Site Will Not Grant Permission for Any Other Use Held by the Owner of the
Copyright.
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(BHAGAVAN SRI SATHYA SAI BABA ASHTOTRA SHATHANAAVALI)

The English translation was authored by Rameesh & Ananda Kasturi of India in the booklet:
A BOUQUET OF108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHY SAI BABA.
The melody was transcribed as sung weekly by the Sai Center of South Miami, Florida, USA.

Harmonizations submitted by the transcriber. (13 April 1998)
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1. Om Sri Sai, You are our Divine Mother, Divine Father and Divine Teach- er, Na - ma - hah.......
1. Om Sri Sal,Sathya Sai Baa-........c...cccooiiiiiiiii e baa - ya Na-ma- hah.......
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2.0m Sri Sai, You are the Embodiment of Truth, Na - ma - hah.......
2.0m Sri Sai, Sathya Svaroopaaya...................... Na - ma - hah.......
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3.0m Sri Sai, Your Mission is the revival of Truth and Righteousness, Na - ma - hah.......
3.0m Sri Sai, Sathya Dharma Paraayanaaya...........ccccoeceueeeeiiinneeenns Na - ma - hah.......
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4.0m Sri Sa-i, You are the Giver of Boons which promote inner development, Na- ma - hah.......
4.0M Sri Sa -1, Varadaay@......ccooeeeuniiiiee e Na - ma - hah.......
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5.0m Sri Sa-i, You....are the Universal Eternal....Abso..-..lute, Na - ma - hah.......
5.0m Sri Sa-1i, Sat........coeeeennn. Puru-........c..o.oeo.i. shaa..-..ya. Na-ma- hah.......
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6. Om Sri Sai, You are the Embodiment of all virtuous qua- li-ties, Na - ma - hah.......
6. Om Sri Sai,Sathya Gunaath..................c.coiiin. ma-ne Na-ma- hah.......
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7.0m Sri Sai, You promote righteousness, piety and perfection, Na-ma - hah.......
7.0m Sri Sai, Sadhu Vardhanaaya...........c.cccoeveveiiiiiiieiiiinieeneen Na - ma - hah.......
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8. Om Sri Sai, You are the Protector and Sustainer of all good people, Na - ma - hah.......
8. Om Sri Sai, Sadhujana Poshanaaya............cccooeeiiiiiiiiiiiiii Na - ma - hah.......
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9.0m Sri Sa-i, You are the One who knows everything, Na - ma - hah
9.0m Sri Sa-i, Sarvajnaaya
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10.Om Sri Sa-i, You....... are the Beloved of......every-one, Na- ma - hah.......
10.Om Sri Sa-i, Sarva........... Jana Pri-............ yaa..-.ya Na-ma- hah
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11. Om Sri Sai, You are the Motivator of all Universal En-of Bliss, Na - ma - hah.......
11. Om Sri Sai,Sarva Shakthi Moor..........c.ccoooviiivinnnn. daa-ya Na-ma- hah.......
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12. Om Sri Sai, You are the Supreme Manifestation of All Godheads, Na - ma - hah.......
12. Om Sri Sai, Sarveshaaya........c.ccoeviiiiiiiiii e Na - ma - hah.......
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13. Om Sri Sai, You are the One without attachment, Na - ma - hah.......
13. Om Sri Sai, Sarva Sanga Parithyaagine............... Na - ma - hah.......
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14. Om Sri Sa-i, You are the Indweller in everyone's heart, Na-ma - hah.......
14. Om Sri Sa-1, Sarva Antharyaamine............ccc.ccoveennnnnnn. Na - ma - hah.......
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15.0m Sri Sa- i, You....are the Personification of....Glo-ry, Na - ma - hah.......
15.0m Sri Sa-i, Ma......... e, hima....... EITT— atma-ne Na- ma - hah.......
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16. Om Sri Sai, You are the Supreme Lord Shiva, the Embodiment of Aus-pi-cious-ness, Na - ma - hah.......
16. OmM Sri Sai, Mahesvara SVAFK00..........c.ccoiiiuiiiiiiiiee e paa - ya Na-ma-hah......
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17.0Om Sri Sai, You have manifested Yourself in the village Puttaparthi, Na- ma - hah.......
17.Om Sri Sali, Parthi Gramodbhavaaya............c..ccoooiiviiiiiiie, Na - ma - hah.......
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18. Om Sri Sai, You are Omnipresent while Your physical body resides in HolyParthi, Na - ma - hah.......
18. Om Sri Sai, Parthi KShethra NIVAASINE. .........oviiieeeeeeeee e Na - ma - hah.......
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19.Om Sri Sa-i, Your glory and fame is the same as that of Shirdi Sai Baba, Na - ma - hah.......
19.0Om Sri Sa-i, Yasahkaaya Shirdi Vaasine..........ccccoooceiiiiiiiiiieiiiieeeneeeennn Na - ma - hah.......
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20.0Om Sri Sa-i, You.... assumed the form and name: "Jodi Adipalli..So-mappa", Na - ma - hah.......
20.0m Sri Sa-1,Jodi..ccccciiiiiiiiiiiiiiiiiii Aadipalli...................... Somap-paaya Na - ma - hah.......
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21. Om Sri Sai, You have taken human form in the religious kin-group of Sage Bhaarad-va-ja, Na-ma-hah....
21. Om Sri Sai,Bhaaradvaaja RiSNi GO-..........cceiiiiiiiiiiiiiieeecieecceeeecee e traaya Na-ma-hah....
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22.0Om Sri Sai, You are affectionate towards Your devotees like a mother, Na - ma - hah.......
22.0m Sri Sai, Bhaktha Vathsalaaya...........ccccooveviiiiiiiiiiie e Na - ma - hah.......
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23.0Om Sri Sai, You are the Innermost Self in every being, Na - ma - hah.......
23.0Om Sri Sai, Apaantharaathmane.............cccooooviiieinnnnnn. Na - ma - hah.......
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24.0m Sri Sa-i, You are all Forms of God incarnated in one, Na- ma - hah
24.Om Sri Sa - i, Avathaara Moortaye

....................................... Na - ma - hah.......
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25.0m Sri Sa-i, You............. save us from......... all...fears, Na-ma- hah.......
25.0m Sri Sa-i, Sarva............... Bhaya.......... Nivaa-rine Na - ma - hah.......
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26.Om Sri Sai, You chose to be born in the lineage of Sage Apasthamba's....
................................................... traditional school of spiritual rit-uals, Na - ma - hah

26. Om Sri Sai, Aapasthamba SU..........cooiiiiiiiii e traa-ya Na-ma- hah.......
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27.0m Sri Sai, You grant us the freedom from fear, Na - ma - hah.......
27.0m Sri Sai, Abhaya Pradaaya............ccc..ccieeennn. Na - ma - hah.......
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28. Om Sri Sai, You have willed to take birth in the Ratnakara descendants, Na - ma - hah.......
28. Om Sri Sai, Ratnaakara Vamshodhavaaya............cccoooeveeiiiiiiiiiiiiiiie Na - ma - hah.......
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29.0m Sri Sa-i, Your magnificence is identical to that of Shirdi Sai Baba, Na - ma - hah.......
29.Om Sri Sa-i, Shirdi Sai Abheda Shaktyaavathaaraaya....................... Na - ma - hah.......
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30.Om Sri Sa- 1, You...confer happiness & prosperity upon...your devotees, Na-ma-hah.......
30.0Om Sri Sa-i,Sham............. ST karaa........... TP V- WO Na - ma - hah.......
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Sri Sai, You are the re-incarnation of Shirdi Sai Ba-ba, Na- ma - hah
Sri Sai, Shirdi Sai Moor

........................................ tha-ye Na-ma-hah.......

32.0Om Sri Sai, You are still The Resident of "Dwarakamayi”, Na - ma - hah
32.0m Sri Sai, Dwaarakaamaayi Vaasine
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34.0m Sri Sa-1i, You bestow vigor, energy, intelligence & divine power on us, Na- ma- hah.......
34.0m Sri Sa-i, Shakthi Pradaaya..........cccooiviiiiiiiiiiiiiiic e Na - ma - hah.......
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35.0m Sri Sa-i, You...... save those who surrender.....to God, Na - ma - hah.......
35.0m Sri Sa-1i, Sara......-...... naagatha Thraa......-....naa-ya Na-ma - hah.......
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36.0m Sri Sai, You are the Embodiment of Bliss, Na- ma - hah.......
36.0m Sri Sal,Anan-.......cccoceveviiiiiniinennn. daa-ya Na-ma-hah.....
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37.0m Sri Sai, You are the Granter of Eternal Joy, Na-ma - hah.......
37.0m Sri Sai, Aananda Daaya.............ccccoeeeuuneeenn.. Na - ma - hah.......
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38.Om Sri Sai, You are ever engaged in rescuing those in distress, Na - ma - hah.......
38.0m Sri Sai, Artha Thraana Paraayanaaya..............cccc.cccuueeen. Na - ma - hah.......
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39.Om Sri Sa-i, You are the Savior of the helpless ones, Na - ma - hah.......
39.0m Sri Sa-i, Anaatha Naathaaya.........c.....ccccceeeennnnn. Na - ma - hah.......
A Am Am Dm C/G G7 C F/C C
I )(l I I I I I i | N N I I A f I
S I N N I I | ™ I ™ ™ I ]
[NV I) I I) I') J é ‘/ I) I I'l I/Y I ]
Y < Fa 4 4 S - s <
40.0Om Sri Sa-i, You....... are the One who is always......... with us, Na-ma- hah.......
40.0m Sri Sa-i, Asa........... e haaya Sahaa........ e yaa-ya Na-ma - hah.......
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41.Om Sri Sai, You are affectionately related to everyone in the world, Na-ma - hah.......
41.0Om Sri Sai, LokaBaadha-.........cc..coooveiiiiiiiii i vaa - ya Na - ma - hah.......
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42. Om Sri Sai, You are fostering and guiding the interest of the whole world, Na- ma- hah.......
42. Om Sri Sai, Lokarakshaa Paraayanaaya..............cccooeeiiiiiiiiiiiiiii i Na - ma - hah.......
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43. Om Sri Sai, You are the Divine Master of Mankind, Na - ma - hah.......
43. Om Sri Sai, Lokanathaaya.........c.ccccccevvvvvviviiininnnnnnnn. Na-ma - hah.......
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45. Om 5r| Sa-i, You....are the Divine Trinity: Brahma, Vishnu, Maheshwara;

responsible for creation, preservationand de-..struc-tion, Na-ma-hah..

45. Om Sri Sa-i, Moor................. TP thi Thraya Svaroo................... U paa -ya.. Na-ma-hah..
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46. Om Sri Sai, You are the Giver of Freedom and Liber-a-tion, Na - ma - hah.......
46. Om Sri Sai, Mukthi Pra-...........cccoooiiiiii daa-ya Na-ma-hah.......
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47. Om Sri Sai, You are Perfect and All Powerful, Na - ma - hah.......
47.0m Sri Sai, Kalusha Vidooraaya..................... Na - ma - hah.......
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48. Om Sri Sal, You are full of compassion and kindness, Na - ma - hah.......
48. Om Sri Sai, Karunaakaraaya.............ccoocceeeiiieeinannnnnn. Na - ma - hah.......
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49. Om Sri Sa-i, You are the Sustainer and Supporter of all, Na-ma- hah.......
49.0m Sri Sa-i, Sarva Adhaaraaya.........ccccoccceeieeeeiieinneennnnn. Na - ma - hah.......
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50.Om Sri Sa-1i, You...dwell in the region of the Heart...of all...beings, Na - ma - hah.......
50.0m Sri Sa-i, Sar......... s va Hrud............ EITTT, va..-...sine... Na-ma- hah.......
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51.0m Sri Sai, You are the Giver of fruits of meritorious and be-ne-fi-cent acts, Na- ma - hah.......
51.0m Sri Sai, Punya Phala Pra-.....cc...ccoooviiiiiiiiini e daa - ya Na - ma - hah.......
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52. Om Sri Sai, You are the Savior from consequences of all immoral activities,
52. Om Sri Sai, Sarva Paaya Kshaya Karaaya..........ccc..ccoooiiiiiiiiiiiniiiiceeennn

Na - ma - hah
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53. Om Sri Sai, You are the Healer of all aliments and diseases, Na - ma - hah.......
53. Om Sri Sai, Sarva Roga Nivaarine...........ccccooveveeiiiiiiineennnnn. Na - ma - hah.......
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54.0m Sri Sa-i, You are the Destroyer of all sufferings, Na - ma - hah.......
54.0m Sri Sa-i, Sarva Baadha Haraaya........................ Na - ma - hah.......

Na - ma - hah.......

N Em
[ \J ™ M| I ]
| .. | INT | N | N I I | N | N I ]
| fanY é 1] I\, I\’ 1 1 I\’ I\/ 1 ]
= g —— o '
44, 0Om Sri Sa-i, You nourish and sustain the afflicted ones, Na- ma - hah.......
44.O0m Sri Sa- i, Deenajana Poshanaaya..............ccccoeeveennnnn. Na - ma - hah.......
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55.0m Sri Sa-1i, You...are the One Creator who is praised....eter-nally, Na - ma - hah.......
55.0m Sri Sa-1i, A........ S nantha Nutha Keer.......... T tha-naaya Na - ma - hah.......
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56. Om Sri Sai, You are the Very First Person, the One who was and is, Na - ma - hah.......
56.0mM Sri Sal, Aadi PUINU- ...t shaa- ya Na - ma - hah.......
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57.0m Sri Sai, You are the Infinite Power of the Divine Mother, Na - ma - hah.......
57.0Om Sri Sai, Aadi Shakthaye.........cc.ooiiiiiiiii Na - ma - hah.......
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58. Om Sri Sai, You have delightful and wonderful powers, Na - ma - hah.......
58. Om Sri Sai, Aparoopa Shakthine................ccooooviinnn, Na - ma - hah.......
A Em Dm7 G
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59.0m Sri Sa-i, You are the Formless who has assumed human form, Na - ma - hah.......
59.0m Sri Sa- i, Avyaktha ROOPINE.......c.oooiiiiiiiiiii e Na - ma - hah.......
A Am Am Dm C/G G7 C F/C C
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60. Om Sri Sa-i, You....are the Destroyer of desire....and...anger, Na-ma- hah.......
60. Om Sri Sa-i, Kama........ e krodha............... Dhwam - sine Na-ma - hah.......
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61.Om Sri Sai, You wear golden robes, the color of God, Na-ma- hah.......
61.Om Sri Sai, Kanakaambara Dhaa-................ ri - ne Na - ma - hah.......
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62. Om Sri Sai, Your astonishing actions are not seen in anyone else, Na- ma - hah.......
62. Om Sri Sai, Adbhutha Charyaa..........ccccooviiiiiiiii e, Na - ma - hah.......
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63. Om Sri Sai, You are the Savior in times of calamity, Na- ma - hah.......
63. Om Sri Sai, Aapad Baandhavaaya.................c......... Na - ma - hah.......
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64.0Om Sri Sa-i, You are Supreme Love, Na-ma - hah.......
64. Om Sri Sa-i, Premaatmane.............. Na - ma - hah.......
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65.0m Sri Sa-i, You..arethe Embodiment of...Divine Love, Na- ma - hah.......
65.0m Sri Sa-i, Pre.... TR Ma....cooiiiiennennnn. Moor-thaye Na - ma - hah
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66. Om Sri Sai, You are the Inspirer and Granter of Love in all be-ings, Na - ma - hah.......
66. OM Sri Sai, Prema Pra-......ccooooiiiiiieeeeeeeeeee e daa-ya Na-ma-hah.......
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67.0Om Sri Sai, You are loved by all, Na - ma - hah.......
67.0m Sri Sai, Priyaaya................. Na - ma - hah.......
p C& G Em
A — —r—— |
Ho—F—T= F—e—=2 !
o r
68. Om Sri Sai, You guide and guard the ones who surrender to God, Na - ma - hah.......
68. Om Sri Sai, Bhaktha Priyaaya...........cccooiiiiiiiiiiiiiie e Na - ma - hah.......
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69. Om Sri Sa-i, You are the heavenly 'Wish-fulfilling Tree' for Your devotees, Na - ma - hah
69. Om Sri Sa - i, Bhaktha Mandaaraaya Na - ma - hah
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70.0m Sri Sa-i, You...are playing in the hearts of....your bhakthas,. Na - ma - hah.......
70.0m Sri Sa-1i, Bhaktha....... Jana Hridaya .............. Vi - haaraaya Na - ma - hah.......
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71.Om Sri Sai, You dwell in the hearts of the de- vo-tees, Na - ma - hah.......
71.Om Sri Sai, Bhaktha Jana Hridayala-........... yaa-ya Na-ma-hah.......
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72.0m Sri Sai, You are bound by the devotion of Your followers, Na- ma - hah.......
72.0Om Sri Sai, Bhaktha Paraadheenaaya..............c..coooveviinnn. Na - ma - hah.......
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73.Om Sri Sai, You illuminate the light of devotion and spiritual knowledge Na - ma - hah
73. Om Sri Sai, Bhakthi Jnaana Pradeepaaya

Na - ma - hah
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74.0m Sri Sa-i, You are the Grantor of devotion and wisdom, Na - ma - hah.......
74.0m Sri Sa - i, Bhakthi Jnaana Pradaaya...............cccccoco...... Na - ma - hah.......
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75.0m Sri Sa-i, You..show the path of attaining...right knowledge, Na - ma - hah.......

75.0m Sri Sa-i, Su.... -......jnaana Maarga............ Darsa - kaaya. Na - ma - hah.......
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76.0m Sri Sai, You are the Embodiment of Supreme Wis-dom, Na- ma - hah.......
76. Om Sri Sai, Jnaana Svaroo-

................................. paa-ya Na-ma-hah.......
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77.0m Sri Sai, You are the Giver and Teacher of the 'Gita', Na - ma - hah.......
77.0m Sri Sai, Geethaa Bodhakaaya..........c....cccoeeeviinennnnn. Na - ma - hah.......
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78.0m Sri Sai, You grant the urge for spiritual awareness, Na- ma - hah.......
78.Om Sri Sai, Jnana Siddhidaaya.................ccoeeiiiiiinnnn. Na - ma - hah.......
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—d I‘\ Y I I ]

| 8 1T | N N | I 1 A A I ]

| £anY é | I AY I\, I I I\, I\’ I ]

[ \.)V é 1 OI 1 J ‘ UI ]
79.0m Sri Sa-i, You have a charming Divine Form, Na - ma - hah.......
79.0m Sri Sa-i, Sundararupaaya................c.ccuuneenn. Na - ma - hah.......
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80.0Om Sri Sa-i, You...are the Embodiment of....Pu-rity, Na-ma - hah.......
80.0Om Sri Sa-1i, Pun...... e ya Puru. ...... e shaa-ya Na-ma- hah.......
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81. Om Sri Sai, You bestow the fruits of all ac- tions, Na-ma- hah.......
81.Om Sri Sai,PhalaPra-.....cc.ccccooevuennn.. daa - ya Na - ma - hah.......
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82. Om Sri Sai, You are supreme above all, Na-ma - hah.......
82. Om Sri Sai, Purushothamaaya............. Na - ma - hah.......
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83. Om Sri Sai, You are ever existent and permanent, Na - ma - hah.......

83. Om Sri Sai, Puraana Purushaaya......................... Na - ma - hah.......
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84.0m Sri Sa-i, Your Glory pervades the Universe and transcends it, Na - ma - hah.......
84.0m Sri Sa-i, Atheethaaya..........cocoiiiiiiiii e Na - ma - hah.......

A Am Am Dm C/G G7 C F/C C
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85.0m Sri Sa-i, You......... are be..-.yond Time, Na-ma - hah.......
85.0m Sri Sa-i, Kaa...-...laathee..-..taa..-..ya.. Na-ma - hah.......
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86. Om Sri Sai, You are the Embodiment of Success, Prosperity and Per-fec- tion, Na - ma - hah.......
86. Om Sri Sali, Siddhi ROO-.........oiiiiiii e paa-ya Na-ma-hah.......
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87.0m Sri Sai, Your power of will is immediately effective, Na - ma - hah.......

87.0m Sri Sal, Siddha Sankalpaaya..............cccooceeiviinennnnn.
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88. Om Sri Sai, You bless us with good health and well being, Na - ma - hah.......
88.Om Sri Sai, Aarogya Pradaaya.........ccccoeveiveiiiiiiiniiiiiineeennn. Na - ma - hah.......
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89.0Om Sri Sa-i, You are providing food, shelter and sustenance for all, Na - ma - hah.......
89. Om Sri Sa-i, Annavastradaaya............ccoeeeviiiiiiiiiiiiii e Na - ma - hah.......
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90. Om S Sa-i, You...destroy the cycle of birth and...death sufferings, Na - ma - hah.......
90.Om Sri Sa-i, Sam.....-........ saara Duhkha.............. Kshaya Karaaya Na-ma-hah.......
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91.0Om Sri Sai, You are the Giver of all Desirable Ob-jects, Na - ma - hah.......
91. Om Sri Sai, Sarvaabheeshta Pra-.................... daa-ya Na-ma-hah......
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92. Om Sri Sai, You are full of beneficial virtues, Na - ma - hah.......
92. Om Sri Sai, Kalyana Gunaaya............c......... Na - ma - hah.......
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93.0Om Sri Sai, You are the Destroyer of the Bondage of Karma, Na - ma - hah.......
93. Om Sri Sai, Karma DhwamsSinNe........ccccoouviiiiiiiiiiiiiieeieeeees Na - ma - hah.......
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94.Om Sri Sa-i, You shine in the mind of good persons as brilliant knowledge, Na - ma - hah.......
94.0m Sri Sa-i, Saadhu Maanasa Sobhithaaya..............c.cccooiiiiiiiiiin e, Na - ma - hah.......
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95.0m Sri Sa-i, You..acceptand represent...all re-ligions, Na - ma - hah.......
95.0m Sri Sa-i, Sarva....-...... mata............ Samma-thaaya Na - ma- hah.......
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96. Om Sri Sai, You purify the mind of Your de-vo-tees, Na - ma - hah.......
96. Om Sri Sai, Saadhu Maanasa Parishodha-kaa-ya Na - ma - hah.......
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97. Om Sri Sai, You have planted the Banyan tree as a boon for spiritual enlightenment, Na - ma - hah.......
97. Om Sri Sai, Saadhakaanugraha Vatavriksha Prathishthaapakaaya.......................... Na - ma - hah.......
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98. Om Sri Sai, You are the Destroyer of All Doubts, Na-ma- hah.......
98. Om Sri Sai, Sakala Samsaya Haraaya................ Na - ma - hah.......
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99. Om Sri Sa-i, You are the Teacher of All Spiritual Wisdom, Na - ma - hah.......
99. Om Sri Sa-i, Sakalathathwa Bodhakaaya............c............ Na - ma - hah.......
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100. Om Sri Sa-i, You...are the Lord of...all Yogis, Na - ma - hah.......
100.Om Sri Sa-i, Yo....-....giswa.....-....raa-ya... Na-ma-hah.......
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101. Om Sri Sai, You are revered by the masters of yo- ga, Na-ma-hah.......

101.Om Sri Sai, Yogindra Vandi-...............cceiee thaa-ya Na-ma-hah.......
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102. Om Sri Sal, You are the Granter of Benevolence, Na - ma - hah.......
102. Om Sri Sai, Sarva Mangalakaraaya................... Na - ma - hah.......
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¥ 103.Om Sri Sai, You are the Bestower of All Accomplishments, Na-ma - hah.......
103. Om Sri Sai, Sarvasiddhi Pradaaya........c....ccccoovvvviievennnn. Na - ma - hah.......
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104. Om Sri Sa-i, You are the Remover of Misfortunes, Na - ma - hah.......
104.Om Sri Sa-1i, Aapannivarine...........cccoeeveviiineeennnnnn. Na - ma - hah.......
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105.0m Sri Sa-i, You...destroy physical and....mental distress. Na - ma - hah.......
105.0Om Sri Sa-i, Aar....... e thiha.......... T raa...-.....ya..... Na - ma - hah.......
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106. Om Sri Sai,_— Youare ver-i- ly the Em- bo- di-ment of Peace, Na - ma - hah,_
106. Om Sri Sai,— Shaan - tha__ Moor tha - ye Na - ma - hah,__
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107. Om  Sri Sai,— You are eas-y to be pleased,_ Na - ma - hah,
107. Om  Sri Sai,— Su - la - bhaPra-san-naa - ya, Na - ma - hah,
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108. Om Sri Sai, You are our Be - lov - ed Lord___
108. Om Sri Sai, Bha - ga - van____
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Bha-ga-van_ Sri_ Sath-ya Sa-i Ba. - ba_—____ Na-ma- hah. __
Sri Sath-ya Sa_ - i—_ Baa- - baa- - ya Na-ma- hah.

Copyright - All Rights Reserved. Permission Granted for Non-Commercial Use for the Purpose of Photo-
copying the Music for Personal or Group Devotional Singing. Recording Rights or Mass Redistribution
Rights are Not Granted for Commercial or Non-Commercial Use. Contact the Owner of the Copyright for
Permission. The Web Site Will Not Grant Permission for Any Other Use Held by the Owner of the
Copyright.
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The English translation was authored by Rameesh & Ananda Kasturi of India in the booklet:
A BOUQUET OF108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHY SAI BABA.
The melody was transcribed as sung weekly by the Sai Center of South Miami, Florida, USA.

Harmonizations submitted by the transcriber. (13 April 1998)
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1. Om Sri Sai, You are our Divine Mother, Divine Father and Divine Teach- er, Na- ma- hah.......
1. Om Sri Sal, Sathya Sai Baa-..........ccooeveviiiiiiiecc e baa - ya Na-ma- hah.......
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2.0m Sri Sai, You are the Embodiment of Truth, Na-ma- hah.......

2.0m Sri Sai, Sathya Svaroopaaya...................... Na - ma - hah.......
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3. 0m Sri Sai, Your Mission is the revival of Truth and Righteousness, Na - ma - hah.......
3.0m Sri Sai, Sathya Dharma Paraayanaaya...........cccccoeeeuiveiiiineeenns Na - ma - hah.......
] 1Y I ]
1 T I ]
e 1 1 ]
| = I 1
Em Dm7 G
Fal "
r.a M ——=k . I
!% ’ | 13 17 1 1 17 17 1 ]
,th_ I ‘.-' ‘.-' GJI 1
4.0m Sri Sa- i, You are the Giver of Boons which promote inner development, Na - ma - hah.......
4.0M Sri Sa@ -1, VaradAayaA.....ccoooeuiiiieiie e Na - ma - hah.......
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5.0m Sri Sa-i, You....are the Universal Eternal....Abso..-..lute, Na - ma - hah.......
5.0m Sri Sa-i, Slat ...................... Pjru- ................... shlaa..-..ya. Na - ma - hah.......
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6. Om Sri Sai, You are the Embodiment of all virtuous qua-li-ties, Na - ma - hah.......

6. Om Sri Sai, Sathya Gunaath.....................o. ma-ne Na-ma- hah.......
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7.0m Sri Sai, You promote righteousness, piety and perfection, Na- ma - hah.......
7.0m Sri Sai, Sadhu Vardhanaaya...........ccccccoivviiiiiiiiiniiiiiccee, Na - ma - hah.......
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8. Om Sri Sai, You are the Protector and Sustainer of all good people, Na - ma - hah.......
8. Om Sri Sai, Sadhujana Poshanaaya...........ccoooeeiiiiiniiiiiiiii e Na - ma - hah.......
S - :
| = 1 |
T | B I ]
” Er[l Dm7 G
Pk i, . I
1 1% 1% 1 1 13 17 1 |
Gh‘: I HJ’ C.‘I ]
9.0m Sri Sa-i, You are the One who knows everything, Na - ma - hah.......
9.0m Sri Sa-i, Sarvajnaaya.......cccccccoeiiiiiiiiiiiiineee Na - ma - hah.......
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10.Om Sri Sa-1i, You....... are the Beloved of......every-one, Na-ma- hah.......
10. Om Sri Sa-i, Sarva........... Janj Pri-............ y:?a -.ya Na-ma-hah.......
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11. Om Sri Sai, You are the Motivator of all Universal En-er-gy, Na-ma- hah.......

11. Om Sri Sai,Sarva Shakthi Moor............cccoovviiiiiinnnn, tha-ye Na-ma-hah.......
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12. Om Sri Sai, You are the Supreme Manifestation of All Godheads, Na - ma - hah.......
12. Om Sri Sai, Sarveshaaya........cooeoiiiiiiiiiii e Na - ma - hah.......
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13. Om Sri Sali, You are the One without attachment, Na- ma- hah.......
13. Om Sri Sali, Sarva Sanga Parithyaagine............... Na - ma - hah.......
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14. Om Sri Sa-i, You are the Indweller in everyone's heart, Na - ma - hah.......
14. Om Sri Sa- i, Sarva Antharyaamine............c.cccoeevviennnnnes Na - ma - hah.......
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15.0m Sri Sa-i, You....are the Personification of....Glo-ry, Na - ma - hah.......
15.0m Sri Sa-1, Mell ......... T hiJm ....... ST atmla-ne Na - ma - hah.......
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16. Om Sri Sai, You are the Supreme Lord Shiva, the Embodiment of Aus-pi- cious-ness, Na - ma - hah.......
16. Om Sri Sail, Mahesvara SVAK00..........c.oiiieiiiiii e paa - ya Na-ma-hah.....
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17. Om Sri Sai, You have manifested Yourself in the village Puttaparthi, Na - ma - hah
17.Om Sri Sai, Parthi Gramodbhavaaya

................................................... Na - ma - hah.......
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18. Om Sri Sai, You are Omnipresent while Your physical body resides in Holy Parthi, Na - ma - hah

18. Om Sri Sai, Parthi Kshethra Nivaasine

Na - ma - hah
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19.0m Sri Sa-i, Your glory and fame is the same as that of Shirdi Sai Baba, Na - ma - hah.......
19.0m Sri Sa-i, Yasahkaaya Shirdi Vaasine...........ccccooviiiiiiiiiiiiiiiiiiiiecieees Na - ma - hah.......
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20.0m Sri  Sa-1, You.... assumed the form and name: "Jodi Adipalli..So-mappa”“, Na-ma - hah.......
20.0m Sri  Sa-i, Joldi .................................. Aadjpalli...................... Som’Tlp-paaya Na - ma - hah.......
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21. Om Sri Sai,Bhaaradvaaja Rishi Go-

21. Om Sri Sai, You have taken human form in the religious kin-group of Sage Bhaarad-va- ja, Na-ma-hah....
traaya Na-ma-hah....
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22.0m Sri Sai, You are affectionate towards Your devotees like a mother, Na - ma - hah.......
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22.0m Sri Sai, Bhaktha Vathsalaaya..............cccoooiiiiiiiiii e, Na - ma - hah.......
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23.0m Sri Sai, You are the Innermost Self in every being, Na - ma - hah.......
23.0m Sri Sai, Apaantharaathmane................cccoooiinn. Na - ma - hah.......
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24.0m Sri Sa-i, You are all Forms of God incarnated in one, Na - ma - hah.......
24.0Om Sri Sa - i, Avathaara Moortaye............ccoccceveeieiiiieinnennnn. Na - ma - hah.......
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25.0m Sri Sa-i, You............. save us from......... all...fears, Na-ma- hah.......
25.0m Sri Sa-i, Salrva ............... Bhaya.......... valaa-rme Na - ma - hah.......
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26.Om Sri Sai, You chose to be born in the lineage of Sage Apasthamba’s....
................................................... traditional school of spiritual rit-uals, Na - ma - hah.......
26. Om Sri Sai,Aapasthamba SU.........cccoiiiiiiiiiii e traa-ya Na-ma-hah.......
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27.0m Sri Sai, You grant us the freedom from fear, Na - ma - hah.......

27.0m Sri Sai, Abhaya Pradaaya..........ccccocccevvvennnnnn Na - ma - hah.......
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28. Om Sri Sai, You have willed to take birth in the Ratnakara descendants, Na - ma - hah.......
28. Om Sri Sai, Ratnaakara Vamshodhavaaya..............cccoovvviiiiiiiiiniiineeennn. Na - ma - hah.......
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29.0m Sri Sa-i, Your magnificence is identical to that of Shirdi Sai Baba, Na - ma - hah.......
29.0Om Sri Sa- i, Shirdi Sai Abheda Shaktyaavathaaraaya....................... Na - ma - hah.......
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30.0m Sri Sa-i, You...confer happiness & prosperity upon...your devotees, Na - ma - hah.......
30.0m Sri Sa-1i, Sham............. s karaa........... U V2= WO Na - ma - hah.......
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31. Om Sri Sai, You are the re-incarnation of Shirdi Sai Ba-ba, Na-ma- hah.......
31.Om Sri Sali, Shirdi Sai MOOT.........ccooviiiiiiieee, tha-ye Na-ma- hah.......
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32.Om Sri Sai, You are still The Resident of "Dwarakamayi”, Na- ma - hah.......
32.Om Sri Sai, Dwaarakaamaayi Vaasine..........cc....ccceeeeenn. Na - ma - hah.......
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33. Om Sri Sai, You moved about on the banks of the Chitravathi River in Parthi, Na - ma - hah.......
33. Om Sri Sai, Chithraavathee Thata Puttaparthi Vihaarine.................ccc.....ooee. Na - ma - hah.......
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34.0m Sri  Sa-i, You bestow vigor, energy, intelligence & divine power on us, Na-ma - hah.......
34.0m Sri  Sa-i, Shakthi Pradaaya..........ccccooeviiiiiiiiiice e Na - ma - hah.......
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35.0m Sri Sa-i, You...... save those who surrender.....to God, Na-ma - hah.......
35.0m Sri Sa-i, Sara......-...... naagatha Thraa......-....naa-ya Na-ma - hah.......
| | | |
- I 1 I - ]
i = | - g
L I | | I 1 ]
[_J 1 1




A BOUQUET OF 108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHYA SAI BABA - Page 6
(BHAGAVAN SRI SATHYA SAI BABA ASHTOTRA SHATHANAAVALI)
C G7

..a. C
L L I L I L L ]
#‘ ™S ™ | | ™ I ]
|| 1T 1 - 1 | I I || ]
Li rd ’ ’_ I .-_ d- d I = ]
36. Om Sri Sai, You are the Embodiment of Bliss, Na ma - hah.......
36. Om Sri Sai,Anan-..........ccoccevvviiniinnnnn. daa-ya Na-ma-hah.....
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37. Om Sri Sal, You are the Granter of Eternal Joy, Na - ma - hah.......
37. Om Sri Sai, Aananda Daaya........c...cc.ccceeeuneennnen. Na - ma - hah.......
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38. Om Sri Sai, You are ever engaged in rescuing those in distress, Na - ma - hah.......
38. Om Sri Sai, Artha Thraana Paraayanaaya...........ccc.ccccoeeeeennns Na - ma - hah.......
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39. Om Sri Sa-i, You are the Savior of the helpless ones, Na - ma - hah.......
39. Om Sri Sa-i, Anaatha Naathaaya................cccceeeeennn. Na - ma - hah.......
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40.0m Sri Sa-i, You....... are the One who is always......... with us, Na-ma- hah.......
40 Om Sri Sa-i, Asl,a ........... e haaya Sahaa........ s y?a-ya Na - ma - hah.......
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41. Om Sri Sai, You are affectionately related to everyone in the world, Na - ma - hah.......
41. Om Sri Sai,LokaBaadha-..........ccccoviiiiiiiiiiiicea vaa - ya Na-ma-hah.......
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42. Om Sri Sai, You are fostering and guiding the interest of the whole world, Na - ma - hah
42. Om Sri Sai, Lokarakshaa Paraayanaaya

....................................................... Na - ma - hah.......
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43. Om Sri Sai, You are the Divine Master of Mankind, Na- ma - hah.......
43.Om Sri Sai, Lokanathaaya...........cccooovviiiiiiiiiiinns Na - ma - hah.......
] | ] I ]
7 e I I
I | 1 ]
Em Dm7 G
Fal L
v i s —k ki T ]
!% ’ IT 11 173 I I 173 11 I ]
gh" 1 d.n' i.!' GJI ]

44.0Om Sri Sa-i, You. nourish and sustain the afflicted ones, Na - ma - hah

44.Om Sri Sa-i, Deenajana Poshanaaya..........c....ccooevveennen Na - ma - hah.......
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45. Om Sri Sa-i, You....are the Divine Trinity: Brahma, Vishnu, Maheshwara;
responsible for creation, preservation and de-..struc-tion,Na-ma-hah..
45. Om Sri Sa-i, Moor................. TR thi Thraya Svaroo................... e paa - ya.. Na-ma-hah..
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46. Om Sri Sai, You are the Giver of Freedom and Liber- a-tion, Na- ma - hah.......
46. Om Sri Sai, Mukthi Pra-........cccocoiviiiiiiiiieee, daa-ya Na-ma-hah.......
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47. Om Sri Sai, You are Perfect and All Powerful, Na - ma - hah.......
47.0m Sri Sai, Kalusha Vidooraaya..................... Na - ma - hah.......
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48. Om Sri Sai, You are full of compassion and kindness, Na - ma - hah.......
48. Om Sri Sai, Karunaakaraaya.........c..cccooeeeeeiieinnennnnnen. Na - ma - hah.......
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49.Om Sri Sa-i, You are the Sustainer and Supporter of all, Na - ma - hah.......
49.Om Sri Sa-i, Sarva Adhaaraaya..........ccc.cccoeveveiniiiinnennnnn. Na - ma - hah.......
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50.Om Sri Sa- i, You...dwell in the region of the Heart...of all...beings, Na - ma - hah.......
50.0Om Sri Sa-i, Sa:’ ......... e, va Hrud............ s vell..-...sine... Na - ma - hah.......
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51.Om Sri Sai, You are the Giver of fruits of meritorious and be-ne-fi- cent acts, Na-ma - hah.......
51.0m Sri Sai, Punya Phala Pra-.........ccccccooiiiiiiiii daa - ya Na - ma - hah.......
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52. Om Sri Sai, You are the Savior from consequences of all immoral activities, Na - ma - hah.......
52.Om Sri Sai, Sarva Paaya Kshaya Karaaya...........ccccoeeiiiiiiiniiiiiiiii e, Na - ma - hah.......
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53. Om Sri Sai, You are the Healer of all aliments and diseases, Na-ma - hah.......
53.Om Sri Sai, Sarva Roga Nivaarine..........cccc.occiiiiiiiiinieeinns Na - ma - hah.......
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54.0m Sri Sa- i, Sarva Baadha Haraaya........................ Na - ma - hah.......
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55.0m Sri Sa-i, You...are the One Creator who is praised....eter-nally, Na - ma - hah.......
55.0m Sri Sa-i, A....... LI nantha Nutha Keer.......... e tha-naaya Na - ma - hah.......
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56. Om Sri Sai, You are the Very First Person, the One who was and is, Na - ma - hah.......
56. 0OmM Sri Sai, Aadi PUIU-.......cooiiiiii e shaa-ya Na-ma-hah.......
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57. Om Sri Sai, You are the Infinite Power of the Divine Mother,
57.0Om Sri Sai, Aadi Shakthaye...........cccoooviiiiiiiii e,
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58. Om Sri Sal, You have delightful and wonderful powers, Na - ma - hah.......
58. Om Sri Sai, Aparoopa Shakthine.............cccccooviiiiiinnnnn. Na - ma - hah.......
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59. Om Sri Sa-i, You are the Formless who has assumed human form, Na - ma - hah

59.Om Sri Sa- i, Avyaktha Roopine
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60. Om Sri Sa- i, You....are the Destroyer of desire....and...anger, Na- ma - hah.......
60. Om Sri Sa- i, Kama........ e krTha ............... DhV}/am -sine Na-ma- hah.......
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61. Om Sri Sai, You wear golden robes, the color of God, Na-ma - hah.......
61. Om Sri Sai, Kanakaambara Dhaa-................ ri - ne Na-ma-hah.......
: ] i ] I
e 1 1 1 ]
! I I I ]
“ F. . F Dm .
|. % I I |. % | ]
| ] I}I I 173 I} I
!:I I g I d‘:‘ g ]
62. Om Sri Sai, Your astonishing actions are not seen in anyone else, Na - ma - hah.......
62. Om Sri Sai, Adbhutha Charyaa...........ccooceviiiiiiiii Na - ma - hah.......
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63. Om Sri Sai, You are the Savior in times of calamity, Na - ma - hah.......
63. Om Sri Sai, Aapad Baandhavaaya............c.c..ccceun... Na - ma - hah.......
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64.Om Sri Sa-i, You are Supreme Love, Na - ma - hah.......

64. Om Sri Sa-1i, Premaatmane.............. Na - ma - hah.......
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65.0m Sri Sa-i, You..arethe Embodiment of...Divine Love, Na - ma - hah.......
65.0m Sri Sa-i, Pre..... s 100 1= VU Moor-thaye Na-ma - hah.......
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66. Om Sri Sai, You are the Inspirer and Granter of Love in all
66. Om Sri Sai, Prema Pra-

be-ings, Na - ma - hah..
daa-ya Na-ma- hah

67.0Om Sri Sai, You are loved by all, Na - ma - hah
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67.0Om Sri Sai, Priyaaya................. Na - ma - hah.......
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68. Om Sri Sai, You guide and guard the ones who surrender to God, Na - ma - hah.....
68. Om Sri Sai, Bhaktha Priyaaya

Na - ma - hah....
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69. Om Sri Sa-i, You are the heavenly 'Wish-fulfilling Tree' for Your devotees, Na - ma - hah.......
69. Om Sri Sa - i, Bhaktha Mandaaraaya..............c.ccoeviiiiiiiniiiiiie e Na - ma - hah.......
¥ £ ¥ ]
e e ! i
. Am Am DM c/G 67 C F/C c
#\ T — " T } Y " — ]
a5, T 3I —rr— 1} i} I — . |
¢« ¥ 4 ¥v¢ 2 ! 4 3 &
70.0m Sri Sa-i, You...are playing in the hearts of....your bhakthas,. Na - ma - hah.......
70.0Om Sri Sa-i, Bhaktha....... Jana Hridaya .............. Vi - haaraaya Na - ma - hah.......
| | | |
- 1 | ]
s — 2 : T




A BOUQUET OF 108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHYA SAI BABA- Page 11
(BCHAGAVAN SRI SATHYA SAI BABA ASHTOTRé7SHATHANAAVALI)

~ C
o L T . — L ]
5 == |

71. Om Sri Sai, You dwell in the hearts of the de- vo-tees, Na - ma - hah
71.Om Sri Sai, Bhaktha Jana Hridayala-........... yaa-ya Na-ma-hah
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72.0m Sri Sal, You are bound by the devotion of Your followers, Na - ma - hah

72.0Om Sri Sai, Bhaktha Paraadheenaaya..............cooocoiiiiinnn. Na - ma - hah.......
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73.0Om Sri Sai, You illuminate the light of devotion and spiritual knowledge Na - ma - hah.......
73. Om Sri Sai, Bhakthi Jnaana Pradeepaaya.............ccooevvviiiiiiiiiiiiiinecieeenn, Na - ma - hah.......
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74.0m Sri Sa-i Yo.u are the Grantor of devotion and wisdom, Na -

a- hah.......
74.Om Sri Sa- i, Bhakthi Jnaana Pradaaya..................cc.c....... Na - ma - hah.......
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75.0m Sri Sa-i, You..show the path of attaining...right knowledge, Na - ma - hah .......
75.0m Sri Sa-i, Su..... -......jnaana Maarga............ Darsa - kaaya. Na - ma - hah.......
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76.Om Sri Sai, You are the Embodiment of Supreme Wis-dom, Na-ma - hah
76.0m Sri Sal, Jnaana Svar00-..........cccceeeeevieeennns paa-ya Na-ma-hah
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78.0m Sri Sai, You grant the urge for spiritual awareness, Na - ma - hah.......
78.Om Sri Sai, Jnana Siddhidaaya.................ccoeviiiiininn. Na - ma - hah.......
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79.0m Sri Sa-i, Yod have a charming Divine Form, Na - ma - hah.......

79.0m Sri Sa-i, Sundararupaaya..........c....cccceerernnn Na - ma - hah.......
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80.Om Sri Sa-i, You...are the Embodiment of....Pu-rity, Na-ma- hah.......
80.0Om Sri Sa-i, Pun...... ST ya Puru. ...... e sh?a-ya Na - ma - hah.......
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81.Om Sri Sai, You bestow the fruits of all ac- tions, Na - ma - hah.......
81.0m Sri Sao, PhalaPra-..........cccooevevnnn daa-ya Na-ma-hah......
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82.Om Sri Sai, You are supreme above all, Na - ma - hah.......
82.Om Sri Sai, Purushothamaaya............. Na - ma - hah.......
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83.Om Sri Sai, You are ever existent and permanent, Na - ma - hah.......
83. Om Sri Sai, Puraana Purushaaya..............c.......... Na - ma - hah.......
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84.0Om Sri Sa-i, Your Glory pervades the Universe and transcends it, Na - ma - hah.......

84.0m Sri Sa-i, Atheethaaya..........cccooiiiiiiiiiii e Na - ma - hah.......
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87.0Om Sri Sai, Your power of will is immediately effective,
87.0m Sri Sai, Siddha Sankalpaaya
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88.Om Sri Sai, You bless us with good health and well being, Na - ma - hah.......
88.0Om Sri Sai, Aarogya Pradaaya...........ccccoceviiiiiiniiiniiennenn, Na - ma - hah.......
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89. Om Sr! Sa -i, You are providing food, shelter and sustenance for all, Na - ma - hah.......
89.0m Sri Sa -i, ANNAVasStradaaya..........cccceeeieiiieieieieieeeeeeeeeeeeeeeeeeeeeeaiaiaaes Na - ma - hah.......
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90. Om Sri Sa i, You...destroy the cycle of birth and...death sufferings, Na - ma - hah.......
90. Om Sri Sa-i, Sellm ..... e saara Duhkha.............. Ksll'laya Karaaya Na-ma-hah.......
| |
: £ = ' < = Z :
e I I I I |+ ]
: = < * = : '
N C C G7 C
i ] e :
\!}IJ' || || I -+ -‘1} il || — I
91. Om Sri Sai, You are the Giver of all Desirable Ob-jects, Na - ma - hah.......
91. Om Sri Sai, Sarvaabheeshta Pra-.................... daa-ya Na-ma-hah.......
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85.0m Sri Sa-i, You......... are be..-.yond Time, Na-ma - hah.......
85.0m Sri Sa- i, Kaa...-...laathee..-..taa..-..ya.. Na-ma - hah.......
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86. Om Sri Sai, You are the Embodiment of Success, Prosperity and Per-fec- tion, Na - ma - hah.......
86. Om Sri Sal, Siddhi ROO-.......coiiiiiiiii e paa-ya Na-ma-hah......
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92. Om Sri Sai, You are full of beneficial virtues, Na - ma - hah.......
92. Om Sri Sai, Kalyana Gunaaya...................... Na - ma - hah.......
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93. Om Sri Sai, You are the Destroyer of the Bondage of Karma, Na - ma - hah.......

93. Om Sri Sai, Karma Dhwamsine Na - ma - hah.......
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94.0m Sri Sa-i, You shine in the mind of good persons as brilliant knowledge,
94. Om Sri Sa-i, Saadhu Maanasa Sobhithaaya
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95.0m Sri Sa-i, You..acceptand represent...all re-ligions, Na - ma - hah.......
95.0m Sri Sa-i, Salrva ..... s mata ............ Samma-thaaya Na-ma- hah.......
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96. Om Sri Sai, You purify the mind of Your de- vo-tees, Na - ma - hah.......
96. Om Sri Sai, Saadhu Maanasa Parishodha-kaa-ya Na-ma- hah.......
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97. Om Sri Sai, You have planted the Banyan tree as a boon for spiritual enlightenment, Na - ma - hah
97. Om Sri Sai, Saadhakaanugraha Vatavriksha Prathishthaapakaaya..........................

Na - ma - hah
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Sai, You are the Destroyer of All Doubts, Na - ma - hah....
Sai, Sakala Samsaya Haraaya................

Na-ma - hah.......
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99. Om Sri Sa-i, You are the Teacher of All Spiritual Wisdom, Na - ma - hah.......
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99. Om Sri Sa-i, Sakalathathwa Bodhakaaya......................... Na - ma - hah.......
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100. Om Sri Sa-i, You...are the Lord of...all Yogis, Na - ma - hah.......
100.Om Sri Sa-1i, Yo........giswa.........raa-ya... Na-ma- hah.......
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101. Om Sri Sai, You are revered by the masters of yo- ga, Na- ma- hah.......
101. Om Sri Sai, Yogindra Vandi-.......................... thaa-ya Na-ma- hah.......
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102. Om Sri Sal, You are the Granter of Benevolence, Na - ma - hah.......
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102. Om Sri Sai, Sarva Mangalakaraaya................... Na - ma - hah.......
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103. Om Sri Sai, You are the Bestower of All Accomplishments, Na - ma - hah.......
103. Om Sri Sai, Sarvasiddhi Pradaaya...........cccooeveeiiiiiiinnnnnnnn. Na - ma - hah.......
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104. Om Sri Sa-i, You are the Remover of Misfortunes, Na - ma - hah.......
104. Om Sri Sa-1, Aapannivarine...........ccoooeceeiiineennnn. Na - ma - hah.......
o 5 T
I = 1 ]
- —— I |
. Am T Am Dm c/G 67 c F/C c
:#L T ——— T } Y T ] T
¥ T 3I - & 1} i] —T—t—"1 |
$ & 55 2 g % 3
i

105.Om Sri Sa
105.Om Sri Sa-i, Aar....... S thiha.......... e raa...-.....ya..... Na - ma - hah.......
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106. Om Sri Sai,— You are ver-i- ly the Em- bo- di-ment of Peace, Na - ma - hah,__
106. Om Sri Sai,— Shaan - tha__ Moor tha - ye Na - ma - hah,__
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107.0m  Sri Sai,— You are eas-y to be pleased,— Na - ma - hah,

107.0m  Sri Sai,— Su - la - bhaPra-san-naa - ya,
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Na - ma - hah,
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108. Om Sri Sai, You are our Be - lov - ed Lord___
108. Om Sri Sai, Bha - ga_— - van____
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Bha- ga-van—_—_ Sri- Sath-ya Sa-i Ba- - ba— Na-ma- hah.
Sri Sath-ya Sa_ - i_ Baa- - baa- - y?_ Na-ma- hah.
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A BOUQUET OF 108 GI%MS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHYA SAI BABA

AGAVAN SRI SATHYA SAI BABA ASHTOTRA SHATHANAAVALI)
The English translation was authored by Rameesh & Ananda Kasturi of India in the booklet:
A BOUQUET OF108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHY SAl BABA.
The melody was transcribed as sung weekly by the Sai Center of South Miami, Florida, USA.
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EI? EI? Harmonizations submitted by the transcriber. (13 April 1998) B|97 EI?
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1. Om Sri Sai, You are our Divine Mother, Divine Father and Divine Teach-er, Na - ma - hah.......
1. Om Sri Sal, Sathya Sai Baa-........ccccoeveviiiiiiiieii e baa - ya Na-ma - hah.......
Ab Ab Fm
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[ \Q)\j 1 1 1
2.0m Sri Sai, You are the Embodiment of Truth, Na- ma - hah.......
2.0m Sri Sai, Sathya Svaroopaaya...................... Na - ma - hah.......
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3.0m Sri Sai, Your Mission is the revival of Truth and Righteousness, Na - ma - hah.......
3.0m Sri Sali, Sathya Dharma Paraayanaaya..............cccooeeeuieeiiinnennnnn. Na - ma - hah.......
Gm Fm7 B
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4.0m Sri Sa- i, You are the Giver of Boons which promote inner development, Na - ma - hah
..................................................................................... Na - ma - hah

4.0m Sri Sa- i, Varadaaya

cm Fm b/Bb Bb7 Eb  Absc Eb
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5.0m Sri Sa-i, You....are the Universal Eternal....Abso..-..lute, Na - ma - hah.......
5.0m Sri ia -1, Sato.viiin, Puru-................... shaa..-.ya. Na-ma- hah.......
Eb E B\ﬂ
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6. Om Sri Sai, You are the Embodiment of all virtuous qua-li-ties, Na - ma - hah.......
6. Om Sri Sai, Sathya Gunaath...............cco.coiiiiiiinn, ma-ne Na-ma - hah.......
Ab Ab Fm
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7.0m Sri Sai, You promote righteousness, piety and perfection, Na- ma - hah
7.0m Sri Sai, Sadhu Vardhanaaya

Eb Bb

................................................ Na - ma - hah.......

10.Om Sri Sa-i, You....... are the Beloved of......every-one, Na - ma - hah
10.Om Sri Sa-i, Sarva........... Jana Pri-............ yaa..-.ya Na-ma-hah
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8. Om Sri Sai, You are the Protector and Sustainer of all good people, Na - ma - hah.......
8.0m Sri Sai, Sadhujana Poshanaaya.............ccooccoiiiiiiiiiincii e, Na - ma - hah.......
Gm Fm7 Bb
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9.0m Sri Sa-i, You are the One who knows everything, Na-ma - hah.......
9.0m Sri Sa-i, Sarvajnaaya.........cccccoeeeiieiiiiiiiieiiieeeeaen Na - ma - hah.......
cm cm Fm Ebssb Bb7 Eb  Absc Eb
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(BHAGAVAN SRI SATHYA SAl BABA ASHTOTRA SHAT ANAAVAL)
Eb Eb Eb
A | A A 1 k A A 1
T4 —r— |"\ 1 ™ f ]
I '\UE v_17 é 7 é 7 I "
11. Om Sri Sai, You are the Motivator of all Universal En-er-gy, Na - ma - hah.......
11. Om Sri Sai, Sarva Shakthi Moor...........ccooovviviiiiinnn, thaye Na - ma - hah.......
Ab Ab Fm
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R 12. Om Sri Sai, You are the Supreme Manifestation of All Godheads, Na - ma - hah

12. Om Sri Sali, Sarveshaaya.........occcoiviiiiiiiiii e Na - ma - hah.......
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13. Om Sri Sai, You are the One without attachment, Na - ma - hah.......
13. Om Sri Sai, Sarva Sanga Parithyaagine............... Na - ma - hah.......
Gm Fm7 Bb
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14.Om Sri Sa-i, You are the Indweller in everyone's heart, Na-ma - hah.......
14.0m Sri Sa-i, Sarva Antharyaamine...........c....ccccceeerennnn. Na - ma - hah.......
Cm Cm  Fm Eb/Bb Bb7 Eb Absc Eb
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15.0m Sri Sa-1i, You....are the Personification of....Glo-ry, Na-ma - hah

15.0m Sri Sa-i, Ma......... e, hima....... ST atma-ne Na-ma- hah.......
Eb eb Bb7 Eb
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16. Om Sri Sai, You are the Supreme Lord Shiva, the Embodiment of Aus-pi-cious-ness, Na - ma - hah.......
16. Om Sri Sai, Mahesvara SVaro00.........cc.oiviiiiiiii e paa - ya Na-ma-hah.......
Ab Ab Fm
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17.Om Sri Sai, You have manifested Yourself in the village Puttaparthi, Na-ma- hah.......
17.Om Sri Sai, Parthi Gramodbhavaaya............cc.ccooviiiiiiiiiiii, Na - ma - hah.......
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18. Om Sri Sai, You are Omnipresent while Your physical body resides in Holy Parthi, Na - ma - hah.......
18. Om Sri Sali, Parthi Kshethra NivVaasiNe. ... Na - ma - hah.......
L, om Fm7 Bb
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19.0m Sri Sa-1i, Your glory and fame is the same as that of Shirdi Sai Baba, Na - ma - hah.......
19.0m Sri Sa-i, Yasahkaaya Shirdi Vaasine..........cccooooviiiiiiiiniiiii e Na - ma - hah.......
cm Cm  Fm EIy/BI; Bb7 Eb Absc Eb
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20.0Om Sri  Sa-i, You.... assumed the form and name: "Jodi Adipalli..So-mappa”, Na-ma - hah

20.0m Sri Sa-i,Jdodi...ccccoceviiiiniiiiiiiiiinein Aadipalli...................... Somap-paaya Na-ma- hah.......
b E Bb7  Eb
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ri Sai, You have taken human form in the religious kin-group of Sage Bhaarad-va- ja, Na-ma-hah....
ri Sai,Bhaaradvaaja Rishi GO-.........cccoiiiiiiiiiii e traaya Na-ma-hah....
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22.0m Sri Sal, You are affectionate towards Your devotees like a mother, Na - ma - hah....
22.0m Sri Sai, Bhaktha Vathsalaaya..........ccccooooviiiiiiiiiii e Na - ma - hah.......
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23.0Om Sri Sai, You are the Innermost Self in every being, Na - ma - hah.......
23. Om Sri Sai, Apaantharaathmane............cc....cccooivneennnnnn. Na - ma - hah.......
Gm Fm7 Bb
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24.0m Sri Sa-1, You are all Forms of God incarnated in one, Na - ma - hah.......
24.0m Sri Sa- i, Avathaara Moortaye...........cccccovevieiineiinennnnns Na - ma - hah.......
L, cm cCm  Fm Eb/B Bb7 Eb  Absc Eb
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25.0m Sri Sa-i, You............. save us from......... all...fears, Na-ma-hah.......
25. Om Sri Sa-i, Sarva............... Bhaya.......... Nivaa-rine Na - ma - hah.......
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D) 26. Om Sri Sai, You chose to be born in the lineage of Sage Apasthamba's....
................................................... traditional school of spiritual rit-uals, Na - ma - hah.......
26. Om Sri Sai, Aapasthamba SU..........cooiiiiiiiiie e traa- ya Na-ma-hah.......
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27.Om Sri Sai, You grant us the freedom from fear, Na-ma - hah.......
27.0m Sri Sai, Abhaya Pradaaya.........c....ccocoevennnnnnn. Na - ma - hah.......
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28. Om Sri Sai, You have willed to take birth in the Ratnakara descendants, Na - ma - hah......
28. Om Sri Sai, Ratnaakara Vamshodhavaaya..........c....ccccooviiiiiiiiiiiicennn, Na - ma - hah.....
Gm Fm7 Bb
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29.0m Sri Sa-1i, Your magnificence is identical to that of Shirdi Sai Baba, Na - ma - hah......
29. Om Sri Sa- i, Shirdi Sai Abheda Shaktyaavathaaraaya....................... Na - ma - hah.....
" cm Cm Fm Eb/B Bb7  Eb Absc ?b
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30.Om Sri Sa- i, You...confer happiness & prosperity upon...your devotees, Na - ma - hah....
30.Om Sri Sa-i, Sham............. TP karaa........... PR V2= PSR Na - ma - hah....
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31. Om Sri Sai, You are the re-incarnation of Shirdi Sai Ba-ba, Na-ma - hah.......
31. Om Sri Sai, Shirdi Sai MoOr...........ccocoivviiiiiiiieen tha-ye Na-ma- hah.......
Ab Ab Fm
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32.0Om Sri Sai, You are still The Resident of "Dwarakamayi”, Na- ma - hah.......
32.Om Sri Sai, Dwaarakaamaayi Vaasine...........ccc..occceeee. Na - ma - hah.......



42. Om Sri Sal, You are fostering and guiding the interest of the whole world, Na - ma - hah
42. Om Sri Sai, Lokarakshaa Paraayanaaya............ccccoeeveiiieeiiiiiiiineeieieee e Na - ma - hah
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43. Om Sri Sali, You are the Divine Master of Mankind, Na-ma - hah.......
43. Om Sri Sai, Lokanathaaya............cc.ccooevvieiiiiiinnennnnnn Na - ma - hah.......
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33. Om Sri Sai, You moved about on the banks of the Chitravathi River in Parthi, Na - ma - hah.......
33. Om Sri Sai, Chithraavathee Thata Puttaparthi Vihaarine...................ccccooeeol Na - ma - hah.......
- Gm Fm7 Bb
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34.0m Sri Sa-i, You bestow vigor, energy, intelligence & divine power on us, Na- ma - hah.......
34.0m Sri Sa-1i, Shakthi Pradaaya..........cccooooeiiiiiiiiiiiiii e Na - ma - hah.......
.\ cm Cm Fm Ebssb Bb7 Eb Absc Eb
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35.0m Sri Sa-i, You...... save those who surrender.....to God, Na - ma - hah.......
35.0m Sri Sa-i, Sara...... e naagatha Thraa......-...naa-ya Na-ma- hah.......
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36.Om Sri Sai, You are the Embodiment of Bliss, Na-ma - hah.......
36.0m Sri Sal,Anan-......ccccoeviviiiieninnnns daa - ya Na - ma - hah.......
Ab Ab Fm
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37.0m Sri Sai, You are the Granter of Eternal Joy, Na- ma - hah.......
37.0m Sri Sai, Aananda Daaya.........cc.cccocceveeueennne. Na - ma - hah.......
EI? Bb Gm
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38.0Om Sri Sai, You are ever engaged in rescuing those in distress, Na- ma - hah.......
38.0m Sri Sai, Artha Thraana Paraayanaaya...........ccccccceeveeennnnnes Na - ma - hah.......
" Gm Fm7 Bb
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39.0m Sri Sa-i, You are the Savior of the helpless ones, Na - ma - hah.......
39.0Om Sri Sa-i, Anaatha Naathaaya.............................. Na - ma - hah.......
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40.0m Sri Sa-i, You....... are the One who is always......... with us, Na-ma-hah.......
40.0m Sri  Sa-i, Asa........... e haaya Sahaa........ s yaa-ya Na-ma-hah.......
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41. Om Sri Sai, You are affectionately related to everyone in the world, Na- ma - hah.......
41.0m Sri Sai, LokaBaadha-..........cocooiviiiiiiiiiiiiiiciiiea vaa - ya Na - ma - hah.......
Ab Ab Fm
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44.0m Sri Sa-i, You nourish and sustain the afflicted ones, Na - ma - hah.......
44.Om Sri Sa-i, Deenajana Poshanaaya...........ccccceevvvnennnnn.. Na - ma - hah.......
., Cm cm Fm Eb/Bb Bb7 Eb aAbsc  Eb

45. Om Sri Sa-i, You....are the Divine Trinity: Brahma, Vishnu, Maheshwara;
responsible for creation, preservation and de-..struc-tion, Na-ma-hah..

45. Om Sri Sa-i, Moor............... TR thi Thraya Svaroo...........,.... T PTPT paa - ya.. Na-ma-hah..
Eb Eb Bb7 Eb
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46. Om Sri Sai, You are the Giver of Freedom and Liber-a-tion, Na- ma - hah

46. 0Om Sri Sal,MuKthi Pra-........cccooooiiiiiiiiiiieee daa-ya Na-ma- hah..............
Ab Ab Fm
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47. Om Sri Sai, You are Perfect and All Powerful, Na - ma - hah.......
47.0m Sri Sai, Kalusha Vidooraaya..................... Na - ma - hah.......
Eb Bb Gm
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48. Om Sri Sal, You are full of compassion and kindness, Na - ma - hah.......
48. Om Sri Sai, Karunaakaraaya............ccccceveiineiieiannnenn. Na - ma - hah.......
. Gm Fm7 Bb
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49. Om Sri Sa-i, You are the Sustainer and Supporter of all, Na-ma- hah.......
49.0m Sri Sa- 1, Sarva Adhaaraaya...........cc.ccoovvveviiiiiineinnnnnn. Na - ma - hah.......
Cm Fm Eb/Bb Bb7 b absc Eb
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50. Om Sri Sa- i, You...dwell in the region of the Heart...of all...beings, Na - ma - hah.......
50.Om Sri Sa-i, Sar......... e va Hrud............ T va..-...sine... Na-ma - hah.......
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51.Om Sri Sai, You are the Giver of fruits of meritorious and be-ne-fi-cent acts, Na- ma - hah.......
51.0m Sri Sai,PunyaPhalaPra-.......ccccccooiiiiiiiiiii e daa-ya Na-ma-hah......
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52. Om Sri Sai, You are the Savior from consequences of all immoral activities, Na-ma- hah.......
52. Om Sri Sai, Sarva Paaya Kshaya Karaaya..............cccoeveviiniiiiiiiiineee Na - ma - hah.......
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53. Om Sri Sai, You are the Healer of all aliments and diseases, Na- ma - hah.......
53.0Om Sri Sai, Sarva Roga Nivaarine..........cccccoiiviiiiiiiiineinnnne, Na - ma - hah.......
Gm Fm7 Bb
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54.0Om Sri Sa-i, You are the Destroyer of all sufferings, Na - ma - hah.......
54. Om Sri Sa-i,

Sarva Baadha Haraaya

Na - ma - hah
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65.0m Sri Sa-i, You..are the Embodiment of....Divine Love, Na - ma - hah.......
65.0m Sri Sa-i, Pre..... e MaA.....cciiiiieneenn. Moor-thaye Na-ma - hah.......
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55.0m Sri Sa-i, You....are the One Creator who is praised....eter-nally, Na - ma - hah.......
55.0m Sri Sa-1i, A........ e nantha Nutha Keer.......... S tha-naaya Na - ma - hah.......
Eb Eb Bb7 Eb
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56. Om Sri Sai, You are the Very First Person, the One who was and is, Na - ma - hah.......
56.0mM Sri Sai, Aadi PUIU-.........ouiii e shaa-ya Na - ma - hah.......
Ab Ab Fm
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57.0m Sri Sai, You are the Infinite Power of the Divine Mother, Na - ma - hah.......
57.0m Sri Sai, Aadi Shakthaye.............cooooiiiiiii Na - ma - hah.......
Eb B Gm
h | A
A B — o -~ |
[ E— ——T— Hr—t—F |
|4 |4 |4 [
58. Om Sri Sai, You have delightful and wonderful powers, Na - ma - hah.......
58. Om Sri Sai, Aparoopa Shakthine.................ccoooiiine Na - ma - hah.......
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59.0m Sri Sa-i, You are the Formless who has assumed human form, Na - ma - hah.......
59.0m Sri Sa-i, Avyaktha ROOPINE.........ccoviiiiiiiiiiieee e, Na - ma - hah.......
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60. Om Sri Sa- i, You....are the Destroyer of desire....and...anger, Na - ma - hah.......
60. Om Sri Sa-i, Kama........ S krodha............... Dhwam - sine Na - ma - hah.......
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61.Om Sri Sai, You wear golden robes, the colorof God, Na-ma- hah.......
61.Om Sri Sai, Kanakaambara Dhaa-................ ri - ne Na - ma - hah.......
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62. Om Sri Sai, Your astonishing actions are not seen in anyone else, Na- ma - hah.......
62. Om Sri Sai, Adbhutha Charyaa...........ccoccovviiiiiiiii e, Na - ma - hah.......
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63. Om Sri Sai, You are the Savior in times of calamity, Na - ma - hah.......
63. Om Sri Sai, Aapad Baandhavaaya.............c.....c....... Na - ma - hah.......
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64.0Om Sri Sa-i, You are Supreme Love, Na-ma - hah.......
64.Om Sri Sa-i, Premaatmane.............. Na - ma - hah.......
" cm cm Fm Eb/Bb Bb7 Eb Absc Eb
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72.0m Sri Sai, You are bound by the devotion of Your followers, Na - ma - hah
72. Om Sri Sai, Bhaktha Paraadheenaaya

Eb Bb

................. Na-ma - ha

h....
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73. Om Sri Sai, You illuminate the light of devotion and spiritual knowledge Na - ma - hah.......
73. Om Sri Sai, Bhakthi Jnaana Pradeepaaya...........cccoovvvevniiiiiniciniiiecennn e Na - ma - hah.......
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74.0m Sri Sa-i, You are the Grantor of devotion and wisdom, Na - ma - hah.......
74.Om Sri Sa - i, Bhakthi Jnaana Pradaaya.................cccc..o.... Na - ma - hah.......
cm cm Fm Eb/Bb Bb7 Eb Absc Eb
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75.0m Sri Sa-i, You..show the path of attaining...right knowledge, Na - ma - hah.......
75.0m Sri Sa-i, Su..... -......jnaana Maarga............ Darsa - kaaya. Na - ma - hah.......
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76.0m Sri Sai, You are the Embodiment of SupremeWis-dom, Na - ma - hah.......
76.0m Sri Sal, Jnaana Svaro0-..........ccceeeeuiveiiinneennnn. paa-ya Na-ma-hah.......

A Ep (BHAGAVAN SRI SATHYA SAI BABA ASHTOTRA SHATHABIAAVALI) E
A A 1 k A A 1
A5 Pr—r N——T—P— |
I '\Q)E v_17 é é I a° 7
66. Om Sri Sai, You are the Inspirer and Granter of Love in all be-ings, Na - ma - hah.......
66. OmM Sri Sai, Prema Pra-.......cooouiiii e daa-ya Na-ma- hah.......
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° 67.0Om Sri Sai, You are loved by all, Na-ma - hah.......
67. Om Sri Sali, Priyaaya................. Na - ma - hah.......
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68. Om Sri Sal, You guide and guard the ones who surrender to God, Na - ma - hah.......
68. Om Sri Sai, Bhaktha Priyaaya.......cc...cccooiiiiiiiiiiiiee Na - ma - hah.......
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69. Om Sri Sa-i, You are the heavenly 'Wish-fulfilling Tree' for Your devotees, Na - ma - hah.......
69. Om Sri Sa - i, Bhaktha Mandaaraaya.........ccccccoeeiiiiiiiiiiiicceeececeeeeea Na - ma - hah.......
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70.0m Sri Sa-i, You...are playing in the hearts of....your bhakthas,. Na - ma - hah.......
70.0m Sri Sa-i, Bhaktha....... Jana Hridaya .............. Vi - haaraaya Na - ma - hah.......
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A | A A 1 k A A 1
54 P—Hr— N—P P —r— |
: %ﬂu a7 Y Ea— — e e e e —
71.Om Sri Sai, You dwell in the hearts of the de- vo-tees, Na - ma - hah.......
71. Om Sri Sai, Bhaktha Jana Hridayala-........... yaa-ya Na-ma- hah.......
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87.0Om Sri Sai, Your power of will is immediately effective, Na - ma - hah
87.0Om Sri Sai, Siddha Sankalpaaya

Na - ma - hah
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77.Om Sri Sai, You are the Giver and Teacher of the 'Gita’, Na - ma - hah.......
77.0m Sri Sai, Geethaa Bodhakaaya..............cccooeevviieennnn. Na - ma - hah.......
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78.0m Sri Sai, You grant the urge for spiritual awareness, Na - ma - hah.......
78.0m Sri Sai, Jnana Siddhidaaya.............cccooeeeiiiiiinnnnnn.. Na - ma - hah.......
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79.0Om Sri Sa-i, You have a charming Divine Form, Na-ma - hah.......
79. Om Sri Sa-i, Sundararupaaya.............c.ccceeevvnnnn. Na - ma - hah.......
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80.Om Sri Sa-i, You...are the Embodiment of....Pu-rity, Na- ma- hah.......
80.0Om Sri Sa-i, Pun...... s ya Puru. ...... e shaa-ya Na-ma- hah.......
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81. Om Sri Sai, You bestow the fruits of all ac- tions, Na-ma- hah.......
81.Om Sri Sai,PhalaPra-.....cccccocovvviiinnn. daa - ya Na - ma - hah.......
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82. Om Sri Sai, You are supreme above all, Na - ma - hah.......
82. Om Sri Sai, Purushothamaaya............. Na - ma - hah.......
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83. Om Sri Sai, You are ever existent and permanent, Na- ma - hah.......
83.Om Sri Sai, Puraana Purushaaya..............c.......... Na - ma - hah.......
.\ Gm Fm7 Bb
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84. Om Sri Sa-i, Your Glory pervades the Universe and transcends it, Na - ma - hah.......
84.0m Sri Sa-i, Atheethaaya.........ccooouiiiiiiiiiii e Na - ma - hah.......
Cm Cm  Fm ebssh  Bb7  Eb  Absc Eb
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85.0m Sri Sa-i, You......... are be..-.yond Time, Na-ma- hah.......
85.0m Sri Sa-i, Kaa...-...laathee..-..taa..-..ya.. Na-ma - hah.......
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86. Om Sri Sai, You are the Embodiment of Success, Prosperity and Per-fec- tion, Na - ma - hah.......
86. Om Sri Sai, Siddhi ROO-......ccooiiiiiiii e paa-ya Na-ma-hah......
Ab Ab Fm
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88. Om Sri Sai, You bless us with good health and well being, Na - ma - hah.......
88. Om Sri Sai, Aarogya Pradaaya.........ccccooeeuiieeiiiiiiiiieiineeennn. Na - ma - hah.......
" Gm Fm7 Bb
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89.Om Sri Sa-i, You are providing food, shelter and sustenance for all, Na - ma - hah.......
89.0m Sri Sa-i, ANNavastradaaya..........cccoeeeeviiiiiiiiiiiiinee e Na - ma - hah.......
" cm cm Fm b/ Bb7 Eb Absc Eb
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90. Om Sri Sa-i, You...destroy the cycle of birth and...death sufferings, Na - ma - hah.......
90. Om Sri ia -1, Sam.....-........ saara Duhkha.............. Ksha a Karaaya Na-ma-hah.......
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91. Om Sri Sai, You are the Giver of all Desirable Ob-jects, Na - ma - hah.......
91. Om Sri Sai,Sarvaabheeshta Pra-.................... daa-ya Na-ma-hah.......
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92. Om Sri Sai, You are full of beneficial virtues, Na - ma - hah.......
92. Om Sri Sai, Kalyana Gunaaya...................... Na - ma - hah.......
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93. Om Sri Sai, You are the Destroyer of the Bondage of Karma, Na - ma - hah.......
93. Om Sri Sai, Karma DhwamsSIiNe.........cocoieiieiiiiiiieiieeeeeeeeen Na - ma - hah.......
L, om Fm7 Bb
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94.0Om Sri Sa-i, You shine in the mind of good persons as brilliant knowledge, Na - ma - hah

94.0Om Sri Sa-i, Saadhu Maanasa Sobhithaaya............ccc..oociiiniiiiii . Na - ma - hah.......
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95.0m Sri Sa-1i, You..acceptand represent...all re-ligions, Na- ma - hah.......
95.0m Sri Sa-i, Sarva....-...... mata............ Samma-thaaya Na-ma - hah.......
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96. Om Sri Sai, You purify the mind of Your de-vo- tees, Na - ma - hah.......
96. Om Sri Sai, Saadhu Maanasa Parishodha-kaa- ya Na-ma - hah.......
Ab Ab Fm
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97. Om Sri Sai, You have planted the Banyan tree as a boon for spiritual enlightenment, Na - ma -hah..

97. Om Sri Sai, Saadhakaanugraha Vatavriksha Prathishthaapakaaya........................... Na - ma -hah..
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98. Om Sri Sai, You are the Destroyer of All Doubts, Na - ma - hah.......
98. Om Sri Sai, Sakala Samsaya Haraaya................ Na - ma - hah
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99. Om Sri Sa-i, You are the Teacher of All Spiritual Wisdom, Na - ma - hah.......
99. Om Sri Sa-i, Sakalathathwa Bodhakaaya......................... Na - ma - hah.......
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100.Om Sri Sa-1i, You..are the Lord of...all Yogis, Na - ma- hah.......
100.Om Sri Sa-i, Yo.....-....giswa.....-....raa-ya... Na-ma- hah.......
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101. Om Sri Sai, You are revered by the masters of yo- ga, Na-ma- hah.......
101. Om Sri Sai, Yogindra Vandi-...............cccceeeun.s thaa-ya Na-ma- hah.......
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102. Om Sri Sai, You are the Granter of Benevolence, Na - ma - hah.......
102. Om Sri Sai, Sarva Mangalakaraaya................... Na - ma - hah.......
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103. Om Sri Sai, You are the Bestower of All Accomplishments, Na - ma - hah.......
103. Om Sri Sai, Sarvasiddhi Pradaaya.........cccc..cccoevevviinieennnnnn. Na - ma - hah.......
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104. Om Sri Sa-i, You are the Remover of Misfortunes, Na - ma - hah.......
104.Om Sri Sa- i, Aapannivarine........c.c.ccccceeveeveinnnenennn. Na - ma - hah.......
. cm cm Fm Ebssb Bb7 b Absc Eb
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105.0m Sri Sa-1i, You...destroy physical and....mental distress. Na - ma - hah.......
105.0m Sri Sa-i, Aar....... s thiha.......... eeereen raa...-.....ya..... Na - ma - hah.......
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106. Om Sri Sai,— You are ver-i- ly the Em - bo- di-ment of Peace, Na - ma - hah._—
106. Om Sri Sai,_bShaan - tha Moor___ - tha - ye, Na - ma - hah._
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107. Om  Sri Sai,—_You are eas-y to be pleased,_— Na - ma - hah
107. Om Sri Sai,— Su - la - bhaPra-san-naa - ya, Na - ma - hah
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108. Om Sri Sai, You are our Be - lov - ed Lord
108. Om Sri Sai, Bha - ga vaan
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Bha-ga-van_ Sri_ Sath-ya Sa-i Ba_ - ba__—__ Na- ma- hah.
Sri Sath-ya Sa__- i Baa. - baa_ - ya,— Na-ma- hah.
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Permission. The Web Site Will Not Grant Permission for Any Other Use Held by the Owner of the
Copyright.
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(BHAGAVAN SRI SATHYA SAI BABA ASHTOTRA SHATHANAAVALI)

The English translation was authored by Rameesh & Ananda Kasturi of India in the booklet:
A BOUQUET OF108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHY SAI BABA.
The melody was transcribed as sung weekly by the Sai Center of South Miami, Florida, USA.
Harmonizations submitted by the transcriber. (13 April 1998)
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1. Om Sri Sai, You are our Divine Mother, Divine Father and Divine Teach- er,

Na - ma - hah

baa - ya Na-ma- hah

1. Om Sri Sai, Sathya Sai Baa-
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2.0Om Sri Sai, You are the Embodiment of Truth, Na - ma - hah.......
2.0m Sri Sai, Sathya Svaroopaaya...................... Na - ma - hah.......
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3.0m Sri Sai, Your Mission is the revival of Truth and Righteousness, Na - ma - hah.......
3.0m Sri Sai, Sathya Dharma Paraayanaaya.............ccccooeeeuiveiiinenennnn. Na - ma - hah.......
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4.0m Sri Sa-1, You are the Giver of Boons which promote inner development, Na - ma - hah.......
4.0M Sri SA -1, Varada@aya.....cccccuiiiieie e s Na - ma - hah.......
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5.0m Sri Sa-i, You....are the Universal Eternal....Abso..-..lute, Na - ma - hah.......
5.0m Sri Sa-i, Sis\t ...................... Puru-................... shaa..-.ya. Na-ma- hah.......
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6. Om Sri Sali, Sathya Gunaath ma-ne

6. Om Sri Sai, You are the Embodiment of all virtuous qua-li-ties, Na - ma - hah

Na - ma - hah
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7.0m Sri Sai, You promote righteousness, piety and perfection, Na-ma - hah.......
7.0m Sri Sai, Sadhu Vardhanaaya.........cccoocoviiiiiiiiiiiiiiiiiies Na - ma - hah.......
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8. Om Sri Sai, You are the Protector and Sustainer of all good people, Na - ma - hah.......
8. 0m Sri Sai, Sadhujana Poshanaaya..............ccccoveiiiiiiiiii i Na - ma - hah.......
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9.0m Sri Sa-1i, You are the One who knows everything, Na- ma - hah.......
9.0m Sri Sa-i, Sarvajnaaya......ccccccceeieeeriiiiiiiineiieeeeens Na - ma - hah.......
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10.Om Sri Sa-i, You....... are the Beloved of......every-one, Na-ma - hah.......
10.Om Sri Sa-i, Sarva........... Jana Pri-............ yaa..-.ya Na-ma-hah.......
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11. Om Sri Sai, You are the Motivator of all Universal En-er-gy,

11. Om Sri Sai,Sarva Shakthi Moor............cccoeiviiiiiinnnne. tha-ye Na-ma-hah.......
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12. Om Sri Sai, You are the Supreme Manifestation of All Godheads, Na - ma - hah

12. Om Sri Sai, Sarveshaaya Na - ma - hah
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13. Om Sri Sai, You are the One without attachment, Na- ma - hah.......
13. Om Sri Sai, Sarva Sanga Parithyaagine............... Na - ma - hah.......
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14. Om Sri Sa-1, You are the Indweller in everyone's heart, Na- ma - hah.......
14. Om Sri Sa-i, Sarva Antharyaamine.............cccocoiveennenn. Na - ma - hah.......
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15.0m Sri Sa-1, You....are the Personification of....Glo-ry, Na - ma - hah.......
15.0m Sri Sa-i, Ma......... e, hima....... e atma-ne Na-ma- hah.......
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16. Om Sri Sai, You are the Supreme Lord Shiva, the Embodiment of Aus-pi- cious-ness, Na - ma - hah

16. Om Sri Sai, Mahesvara Svaroo paa - ya Na-ma-hah
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18. Om Sri Sai, You are Omnipresent while Your physical body resides in Holy Parthi, Na - ma - hah.......
18. Om Sri Sai, Parthi Kshethra NIVaasSiNe........c.c.ooiiiiii e e Na - ma - hah.......
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19.0Om Sri Sa-i, Your glory and fame is the same as that of Shirdi Sai Baba, Na - ma - hah.......
19.0m Sri Sa- i, Yasahkaaya Shirdi Vaasine.........ccccooooviiiiiiiiiiiiii e, Na - ma - hah.......
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20.0m Sri Sa- i, You.... assumed the form and name: "Jodi Adipalli..So-mappa”’, Na-ma- hah.......
20.0m Sri Sa-i,Jodi.cccceciiiiiiiiiiiieiiie Aadipalli...................... Somap-paaya Na-ma - hah.......
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traaya Na-ma-hah....
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21. Om Sri Sai, You have taken human form in the religious kin-group of Sage Bhaarad-va- ja, Na-ma-hah....
21. Om Sri Sai,Bhaaradvaaja Rishi Go-

-

TE=——




A BOUQUET OF 108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHYA SAI BABA - Page 4

(BHAGAVAN SRI SATHYA SAI BABA ASHTOTRA SHATHANAAVALI)
Ab Ab
A b, b b,
| 1 | B T | I 13 11 ]
| I i ]
=3 ! 2 !
22.0m Sri Sali, You are affectionate towards Your devotees like a mother, Na - ma - hah.......
22.0m Sri Sai, Bhaktha Vathsalaaya............cccooooviiiiiiiiiiiiiii e Na - ma - hah.......
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23.Om Sri Sai, Apaantharaathmane.................cccooivee. Na - ma - hah.......
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24.Om Sri Sa-i, You are all Forms of God incarnated in one, Na - ma - hah.......
24.0m Sri Sa- i, Avathaara Moortaye.........cccccooevueiveeiiineeennnen. Na - ma - hah.......
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25.0m Sri Sa-i, You save us from......... all...fears, Na - ma - hah.......
25.0m Sri Sa-i, Sarva Bhaya.......... Nivaa-rine Na - ma - hah.......
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26.0m Sri Sai, You chose to be born in the lineage of Sage Apasthamba'’s....
................................................... traditional school of spiritual rit-uals, Na - ma - hah.......
26.0Om Sri Sai, Aapasthamba SU..........cccuiiiiiiiiiii e traa-ya Na-ma-hah.......
1 F ]
&El;; ] I ] I
Ll 7] I I I ]
' A Ab F
A ‘S T
o T 17 a1 || I 13 13 ]
b5 5o T
27.0m Sri Sai, You grant us the freedom from fear, Na - ma - hah.......
27.0m Sri Sai, Abhaya Pradaaya..............ccccoeeeunnnenn. Na - ma - hah.......
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28. Om Sri Sai, You have willed to take birth in the Ratnakara descendants, Na - ma - hah.......




A BOUQUET OF 108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHYA SAI BABA - Page 5
(BHAGAVAN SRI SATHYA SAI BABA ASHTOTRA SHATHANAAVALI)

A | eR_,_Fm7 Bb
T I " O — —h i T ]
% B T e ] il} il} ] |
y= 0 I T ]
(3] -

29.0Om Sri Sa-i, Your magnificence is identical to that of Shirdi Sai Baba, Na - ma - hah.......
29.0m Sri Sa- i, Shirdi Sai Abheda Shaktyaavathaaraaya....................... Na - ma - hah.......
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30.0m Sri Sa-i, You...confer happiness & prosperity upon...your devotees, Na - ma - hah.......
30.0m Sri Sa-i, Sham............. LI karaa........... e 7= VT Na - ma - hah.......
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31. Om Sri Sai, You are the re-incarnation of Shirdi Sai Ba-ba, Na-ma - hah.......

31. Om Sri Sai, Shirdi Sai MoOr.......cc.coooviiiiiiiiiiieieee tha-ye
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Na - ma - hah.......
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32.0Om Sri Sai, You are still The Resident of "Dwarakamayi”, Na - ma - hah.......
32. Om Sri Sai, Dwaarakaamaayi Vaasine..............c.cccceeeennnn. Na - ma - hah.......
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34.0m Sri Sa-i, You bestow vigor, energy, intelligence & divine power on us, Na- ma - hah.......
34.0m Sri  Sa-i, Shakthi Pradaaya..........ccccoooiiiiiiiiiiiiii e Na - ma - hah.......
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35.0m Sri Sa-i, You...... save those who surrender.....to God, Na-ma - hah.......
35.0m Sri Sa-i, Sara......-...... naagatha Thraa......-...naa-ya Na-ma- hah.......
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36. Om Sri Sai, You are the Embodiment of Bliss, Na - ma - hah.......

36. Om Sri Sai, Anan-.........cccocovevviviniinnnn. daa-ya Na-ma-hah.....
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37. Om Sri Sai, You are the Granter of Eternal Joy, Na-ma- hah.......
37. Om Sri Sai, Aananda Daaya..........c...ccooevuveunnnnn. Na - ma - hah.......
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38. Om Sri Sai, You are ever engaged in rescuing those in distress, Na - ma - hah

38. Om Sri Sai, Artha Thraana Paraayanaaya.............cccc.cccceeeeennn..

Na - ma - hah
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39. Om Sri Sa-i, You are the Savior of the helpless ones, Na - ma - hah.......
39. Om Sri Sa-i, Anaatha Naathaaya..............cccooeeeennne Na - ma - hah.......
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40.0m Sri Sa-i, You....... are the One who is always......... with us, Na-ma- hah.......
40 Om Sri Sa-1i, Asa........... e haaya Sahaa........-........ yaa-ya Na-ma-hah.......
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41. Om Sri Sai, You are affectionately related to everyone in the world, Na- ma - hah.......
41. Om Sri Sai, LokaBaadha-...........cccoooviiiiiiiiiiii vaa - ya Na - ma - hah.......
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42, Om Sri
42. Om Sri
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Na - ma -

Sai, You are fostering and guiding the interest of the whole world, Na - ma - hah.......
Sai, Lokarakshaa Paraayanaaya..........cccooeeeeviiiiiiiieiiiiecciieceeeen

hah.......
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43. Om Sri Sai, You are the Divine Master of Mankind, Na-ma - hah.......
43. Om Sri Sai, Lokanathaaya..........cccccooviiiiiiiiiininn, Na - ma - hah.......
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44. Om Sri Sa-i, You nourish and sustain the afflicted ones, Na - ma - hah.......
44.0Om Sri Sa - i, Deenajana Poshanaaya...........ccccoocevvneeennnn. Na - ma - hah.......
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45. Om Sri Sa-i, You....are the Divine Trinity: Brahma, Vishnu, Maheshwara;
responsible for creation, preservation and de-..struc-tion,Na-ma-hah..
45. Om Sri Sa-i, Moor................. e thi Thraya Svaroo.............. T paa - ya.. Na-ma-hah..
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46. Om Sri Sai, You are the Giver of Freedom and Liber-a-tion, Na- ma - hah
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46. Om Sri Sai, Mukthi Pra-.......cccooooiiiiiiiiiiie, daa-ya Na-ma-hah.......
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47. Om Sri Sai, You are Perfect and All Powerful, Na- ma- hah.......
47.0Om Sri Sai, Kalusha Vidooraaya..................... Na - ma - hah.......
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48. Om Sri Sai, You are full of compassion and kindness, Na - ma - hah.......

48. Om Sri Sali, Karunaakaraaya..........cccooccoeiniiiniiieennnns Na - ma - hah.......
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49.Om Sri Sa-i, You are the Sustainer and Supporter of all, Na - ma - hah

49.0m Sri Sa-i, Sarva Adhaaraaya.........c...ccccoeveeeiiiiiiinennnn... Na - ma - hah.......
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50.Om Sri Sa- i, You...dwell in the region of the Heart...of all...beings, Na - ma - hah.......
50.0m Sri Sa-i, Sar......... TR va Hrud............ e va..-...sine... Na-ma - hah.......
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51. Om Sri Sal, You are the Giver of fruits of meritorious and be-ne-fi- cent acts, Na-ma- hah.......
51.0m Sri Sai, Punya Phala Pra-........c.c.occooiiiiiiiiiiii e daa - ya Na - ma - hah.......
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52.Om Sri Sai, You are the Savior from consequences of all immoral activities, Na - ma - hah.......
52.Om Sri Sai, Sarva Paaya Kshaya Karaaya...........ccccovevuiiiiiiiiiiiiiieeeii e Na - ma - hah.......
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53. Om Sri Sai, You are the Healer of all aliments and diseases, Na - ma - hah.......
53.0Om Sri Sali, Sarva Roga Nivaarine............cccccoovevieiiincinnennnn. Na - ma - hah.......
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54.0m Sri Sa-i, You are the Destroyer of all sufferings, Na - ma - hah.......
54.0m Sri Sa-i, Sarva Baadha Haraaya................c....... Na - ma - hah.......
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55.0m Sri Sa-1i, You...are the One Creator who is praised....eter-nally, Na - ma - hah.......
55.0m Sri Sa-i, A........ ST nantha Nutha Keer.......... ST tha-naaya Na - ma - hah.......
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56. Om Sri Sai, You are the Very First Person, the One who was and is, Na-ma-hah.......
56.0m Sri Sal, Aadi PUIU-.........ooiii e shaa-ya Na-ma-hah.......
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57.0Om Sri Sai, You are the Infinite Power of the Divine Mother, Na - ma - hah.......
57.0m Sri Sai, Aadi Shakthaye.............ccooooiiiiiii Na - ma - hah.......
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58. Om Sri Sai, You have delightful and wonderful powers, Na - ma - hah
58. Om Sri Sai, Aparoopa Shakthine

..................................... Na - ma - hah.......

60. Om Sri Sa-i, You....are the Destroyer of desire....and...anger,

60. Om Sri Sa- i, Kama........ e krodha............... Dhwam - sine Na-ma- hah.......
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61. Om Sri Sai, You wear golden robes, the color of God, Na- ma - hah.......
61. Om Sri Sai, Kanakaambara Dhaa-................ ri - ne Na-ma-hah.......
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Na - ma - hah

62. Om Sri Sai, Your astonishing actions are not seen in anyone else, Na - ma - hah
62. Om Sri Sai, Adbhutha Charyaa
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63. Om Sri Sai, You are the Savior in times of calamity, Na - ma - hah

63. Om Sri Sai, Aapad Baandhavaaya........ Na - ma - hah

i -

=

s

o o
) I I . ]
I N | = I ]
o | TRl = 1 ]
L I I I ]
Gm  Fm7 Bb
L L . . . .
o T 17 I S T | | I I | | I ]
|| 173 173 I I 11 173 I ]
%ﬁ*’:’—dﬂ—y_—#ﬂ 4= 7 :
59. Om Sri Sa-i, You are the Formless who has assumed human form, Na - ma - hah.......
59.0m Sri Sa-i, Avyaktha ROOPINE......cccoooiiiiiiiiii e Na - ma - hah.......
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64.Om Sri Sa-i, You are Supreme Love, Na- ma - hah.......
64.0Om Sri Sa-i, Premaatmane.............. Na - ma - hah.......
o .

] | I I ]

e —F— I I

%) r 1 1 ]

W cm cm Fm Eb/Bb Bb7 Eb  Absc Eb
1 —rT——— ] T — e |
{J"I'l'} L || II\I I I || ’ d.-’ I I I I ]

3] ’- - # [ # L

65.0m Sri Sa-i, You..arethe Embodiment of....Divine Love, Na - ma - hah.......
65.0m Sri Sa-i, Pre..... e MA..iiiiiiieienss Moor-thaye Na - ma - hah.......
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66. Om Sri Sai, You are the Inspirer and Granter of Love in all be-ings, Na - ma - hah
66. Om Sri Sai, Prema Pra-
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daa-ya Na-ma-hah.......
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67.0Om Sri Sai, You are loved by all, Na- ma- hah.......
67.0Om Sri Sai, Priyaaya................. Na - ma - hah.......
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68. Om Sri Sai, You guide and guard the ones who surrender to God,
68. Om Sri Sai, Bhaktha Priyaaya
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69. Om Sri Sa-i, You are the heavenly 'Wish-fulfilling Tree' for Your devotees, Na - ma - hah
69. Om Sri Sa - i, Bhaktha Mandaaraaya

Na-ma - hah.......
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70.0m Sri Sa-i, You...are playing in the hearts of....your bhakthas,. Na - ma - hah.......
70.0m Sri Sa-i, Bhaktha....... Jana Hridaya .............. Vi - haaraaya Na - ma - hah.......
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71. Om Sri Sai, You dwell in the hearts of the de- vo-tees, Na - ma - hah.......
71.Om Sri Sai, Bhaktha Jana Hridayala-........... yaa-ya Na-ma - hah.......
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72. Om Sri Sai, You are bound by the devotion of Your followers, Na- ma - hah.......
72.Om Sri Sai, Bhaktha Paraadheenaaya................ccoeeviviineinnnnn Na - ma - hah.......
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73. Om Sri Sai, You illuminate the light of devotion and spiritual knowledge Na - ma - hah
73. Om Sri Sai, Bhakthi Jnaana Pradeepaaya

Na - ma - hah
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76. Om Sri Sai, You are the Embodiment of Supreme Wis-dom, Na - ma - hah.......
76. Om Sri Sai, Jnaana Svar00-...........ccceveiviininiinennns paa-ya Na-ma-hah.......
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77.Om Sri Sai, You are the Giver and Teacher of the 'Gita', Na - ma - hah.......
77.0m Sri Sai, Geethaa Bodhakaaya.............coccooeiiieiiinn. Na - ma - hah.......
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74.0m Sri Sa-i, You are the Grantor of devotion and wisdom, Na - ma - hah.......
74.0m Sri Sa -1, Bhakthi Jnaana Pradaaya........c......ccccececuun... Na - ma - hah.......
o
] [ = I ]
S T —— 1 |
Ll ) | I I ]
W cm cm Fm Eb/Bb Bb7 Eb Absc eb
#‘ T & L I L L I i 'L L I L L ]
Bl ™ | | S S 1 1 13 | 1 S ™ ]
‘L'IJ'FU || II\II | I ’ d.-’ I I || 11 — I
o = ¥ § ¥ 7
75.0m Sri Sa-i, You..show the path of attaining...right knowledge, Na - ma - hah.......
75.0m Sri Sa-i, Su... -......jnaana Maarga............ Darsa - kaaya. Na - ma - hah.......
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78.0Om Sri Sai, You grant the urge for spiritual awareness, Na - ma - hah.......
78.0m Sri Sai, Jnana Siddhidaaya............cccoooeeeiiviiiiinennnnn.. Na - ma - hah.......
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79.0m Sri Sa-i, You have a charming Divine Form, Na-ma - hah.......
79.0m Sri Sa-i, Sundararupaaya.........c.....cocceeerunnn. Na - ma - hah.......
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80.0Om Sri Sa-1i, You...arethe Embodiment of....Pu-rity, Na - ma - hah.......
80.0Om Sri Sa-i, Pun...... s ya Puru. ...... e shaa-ya Na-ma- hah.......
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81. Om Sri Sai, You bestow the fruits of all ac- tions, Na - ma - hah.......
81.0Om Sri Sao, PhalaPra-......ccc..ccoeeevennnnnn daa-ya Na-ma-hah.......
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82. Om Sri Sai, You are supreme above all, Na - ma - hah.......

82. Om Sri Sai, Purushothamaaya............. Na - ma - hah.......
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83. Om Sri Sai, You are ever existent and permanent, Na - ma - hah.......
83. Om Sri Sai, Puraana Purushaaya........c.....c.......... Na - ma - hah.......
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84.Om Sri Sa-i, Your Glory pervades the Universe and transcends it, Na - ma - hah.......
84.0m Sri Sa-i, Atheethaaya........ccocoiiiiiiiii e, Na - ma - hah.......
o .
r = I ]
S 7 1 |
L ) | I I ]




A BOUQUET OF 108 GEMS OF DIVINE GLORY ATTRIBUTED TO BHAGAVAN SRI SATHYA SAI BABA- Page 13

(BHAGAVAN SRI SATHYA SAl % QASHTOTRA SHAT ANAAVALI)
Fm

W cm Bb7 Eb
| * N 7 L I L L I I L L ]
—{ﬂ;.. b T :r'\l i e ’ J} .". i It It i
¢ o § ¥ T =
85.0m Sri Sa-i, You......... are be..-.yond Time, Na- ma - hah.......
85.0m Sri Sa-i, Kaa...-...laathee..-..taa..-..ya.. Na-ma- hah.......
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86. Om Sri Sai, You are the Embodiment of Success, Prosperity and Per-fec- tion, Na - ma - hah.......
86. Om Sri Sal, Siddhi ROO-.......c.oiiiiii e paa-ya Na-ma-hah.......
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87.0Om Sri Sai, Your power of will is immediately effective, Na - ma - hah.......
87.0m Sri Sai, Siddha Sankalpaaya......c.....ccccooeviviieiiennnn Na - ma - hah.......
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88. Om Sri Sai, You bless us with good health and well being, Na - ma - hah.......
88. Om Sri Sai, Aarogya Pradaaya............cccoccoveiieiiiiiniinnninnnn, Na - ma - hah.......
2-
1 T s = |
e e T |
Ll 7] I I I ]
G " Em7 Bb
L " . . . .
™ B || S 1 | | I I | % .Y I ]
|| 17 17 1 I 171 11 I ]
I%ﬁc’ -] :b: O S— — |

89.Om Sri Sa-i, You are providing food, shelter and sustenance for all, Na-ma- hah.......
89.0m Sri Sa-i, ANnavastradaaya.........cccooeeeiiiiiiiiiiiiiie e Na - ma - hah.......
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90. Om Sri Sa-1, You..destroy the cycle of birth and...death sufferings, Na - ma - hah.......
90.0Om Sri Sa-i, Sam.....-........ saara Duhkha.............. Kshaya Karaaya Na-ma - hah.......
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91. Om Sri Sai, You are the Giver of all Desirable Ob-jects, Na - ma - hah.......
91. Om Sri Sali, Sarvaabheeshta Pra-.................... daa-ya Na-ma-hah......
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92. Om Sri Sai, You are full of beneficial virtues, Na - ma - hah.......
92. Om Sri Sai, Kalyana Gunaaya...................... Na - ma - hah.......
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93. Om Sri Sai, You are the Destroyer of the Bondage of Karma, Na- ma - hah.......
93. Om Sri Sai, Karma Dhwamsine.........cccovviiiiiiiiiiiiiieeeeeen Na - ma - hah.......
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94. Om Sri Sa-i, You shine in the mind of good persons as brilliant knowledge, Na - ma - hah.......
94. Om Sri Sa-i, Saadhu Maanasa Sobhithaaya..............cccoooiiiiiiiiiii Na - ma - hah.......
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95.0m Sri Sa-i, You..accept and represent...all re-ligions, Na - ma - hah.......
95.0m Sri Sa-i, Sarva.....-.... mata............ Samma-thaaya Na - ma - hah.......
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96. Om Sri Sal, You purify the mind of Your de- vo- tees, Na- ma - hah.......
96. Om Sri Sai, Saadhu Maanasa Parishodha- kaa- ya Na-ma- hah.......
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97. Om Sri Sai, You have planted the Banyan tree as a boon for spiritual enlightenment, Na - ma - hah.......

97. Om Sri Sai, Saadhakaanugraha Vatavriksha Prathishthaapakaaya.......................... Na - ma - hah.......
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98. Om Sri Sai, You are the Destroyer of All Doubts, Na - ma - hah.......
98. Om Sri Sai, Sakala Samsaya Haraaya................ Na - ma - hah.......
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99. Om Sri Sa-i, You are the Teacher of All Spiritual Wisdom, Na - ma - hah

99. Om Sri Sa-i, Sakalathathwa Bodhakaaya..............cc......... Na - ma - hah.......
o .
3 P I ]
A TRl | |Fi | I I ]
L ) 1 1 ]
. cm cCm  Fm ebsBp Bb7 Eb  Absc Eb
o T L L I L L I i | Y L I L ]
{‘n;} ", T Ir‘xl i —r—d ’f T i T Y i
¢ t s I
100. Om Sri Sa-i, You..are the Lord of...all Yogis, Na-ma - hah.......
100.Om Sri Sa-i, Yo....-...giswa.....-....raa-ya... Na-ma- hah.......
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101. Om Sri Sai, You are revered by the masters of yo- ga, Na-ma - hah
101.Om Sri Sali, Yogindra Vandi-...............cccuu. thaa-ya Na-ma- hah
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102. Om Sri Sai, Sarva Mangalakaraaya................... Na - ma - hah.......
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103. Om Sri Sai, You are the Bestower of All Accomplishments, Na - ma - hah.......
103. Om Sri Sai, Sarvasiddhi Pradaaya.............cccoovvveiiininnn. Na - ma - hah.......
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104. Om Sri Sa-1i, You are the Remover of Misfortunes, Na - ma - hah.......
104.Om Sri Sa-i, Aapannivarine........ccccccccceenievennnencnnn, Na - ma - hah.......
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105.Om Sri Sa-i, You...destroy physical and....mental distress. Na - ma - hah.......
105.0Om Sri Sa-i, Aar....... e thiha.......... e raa...-.....ya..... Na - ma - hah.......
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106. Om Sri Sai,— Youare ver-i- ly the Em - bo- di-ment of Peace, Na - ma - hah,__
106. Om Sri Sai, Shaan - tha__ Moor tha - ye Na - ma - hah,__
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107.0m Sri Sai,— You are eas-y to be pleased,_ Na - ma - hah,
107.Om Sri Sai,— Su - la- bhaPrasan-naa - ya, Na - ma - hah,
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You are our Be - lov - ed Lord___

108. Om Sri Sai, Bha - ga - van____
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Bha-ga-van__ Sri__ Sath-ya Sa-i Ba- - ba___ Na- ma- hah.__
Sri Sath-ya Sa_ - i—_ Baa. - baa_ - ya__ Na- ma-hah.__
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ADI NARAYANA SAI NARAYANA

Melody transcribed from the recording: LEARNING BHAJANS.
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Glory to Lord Narayana, Sai Narayana the Primal Lord.
Victory to Hari Narayana, Dweller of Pandhari,
and to Sai Narayana, Dweller of (Putta)Parthi.
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ADI NARAYANA SAI NARAYANA

Melody transcribed from the recording: LEARNING BHAJANS.
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Glory to Lord Narayana,

Sai Narayana the Primal Lord.
Victory to Hari Narayana,
Dweller of Pandhari,
and to Sai Narayana,
Dweller of (Putta)Parthi.
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ADI PUJYA DEVA GAJANANA

Melody transcribed from a recording of 108 NAMES AND BHAJANS.
The text and devotional thought adapted from BHAJANAMAVALI.
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First, worship the auspicious Lord Gajanana,

the darling son of Mother Gauri.

He destroys obstacles and confers success.

The entire creation pays obeisance and
worships Thy Lotus Feet.
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ADI PUJYA DEVA GAJANANA

Melody transcribed from a recording of 108 NAMES AND BHAJANS.
The text and devotional thought adapted from BHAJANAMAVALI.

Gm Cm G7 Cm G7 Cm
O—br — S K A . 5
g b | L 11 1 1 ) | N IA) I’) F’ e = [o)
[ fan WL/ | é é é IR i / é L 1] 1
A\SV 1 J’ 1 1 !/ 1
Q) | — |
A_- di Pu_- jya De-va Ga-ja—_- na-na
Gm D7 Gm Cm Fm Cm Gm7 Cm
h I A
Y T Py Py Py Py InN Py
> - —t—F - 7 ma— 5 £
ANSVJ 1 1 |74 |74 1/ L/ 1 e 1] 1”4 1
d T T T T r r I T I
Gau_- ri_- wva-ra Ta- na - ya Shu- bha - na - na——
Gm Cm G7 Cm G7 Cm
Q Ill). N f Y n Y — >
g b | - | 1 I’) | N IR I’) P Fe | [
G R — e e T
[y [ ‘ “ T I
A_ - di Pu_ - jya De-va Ga-ja—- na-na
Fm  Cm Bb G7 cm G7 cm
b . ————————
g b | 1 | I’) P 1 e Py L] F
[ £an WLAEN/ i d é \._/d L | I 1 )
ANSV 1] 1] 1/ 1/ 1] 1 1 1/ 1/
< Yy v r—r | r r
Vigh-- na Vi-na— - sha-ka Sid-dhi Vi-na— - ya-ka
G Cm Gm Cm
h | A A
A0 H—H—e—e st 1t r — L7 — - — — )
[ fan VLAY ™ 1] 1] 1] 1 1 ) i P = P 1] 1
ANSV = |74 |74 |74 1 1/ 1/ = 1] = |74 1
) - - - ! ¥ ¥ 7 - |
Ja-ya Ja-ga Van_- da-na Ta- va Cha-ra- nam_—_

First, worship the auspicious Lord Gajanana,
the darling son of Mother Gauril.
He destroys obstacles and confers success.
The entire creation pays obeisance and
worships Thy Lotus Feet.
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AHO MAHADBHUTA LINGAM

Melody and text provided by Edith Bischel and the Arizona devotees.
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A- ho_ Ma-had - bhu-ta Ling.- am
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Glory to the wonderous Lingam,
The form of the Divine Atma,
The great Sai Shiva Lingam.

LINGAM: The form of God. As in the Shivalingam, the merging of
the form with the formless. Because of the oval shape, there is
no beginning or ending, so it merges with the formless. That in
which this jagath (universe) attains laya (the merging of the
sensory or finite mind in the infinite); symbolizes the goal of
life; 'a symbol'; the symbol of creation.
- -TRANSLATIONS BY BABA (Youngs) p. 83.
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AHO MAHADBHUTA LINGAM

Melody and text provided by Edith Bischel and the Arizona devotees.

[a N | N | \ —
y. = P N ' — —
(© ’ O ] 2
D) 4 & 3 h—J- - - r r— r r—
A - ho Ma - had—- Dbhu- ta Ling- - am
g J | | |
Ls ) 1] ﬁ e i é i
= | | I P
1 A 1 1 —1 2 —1 1
—] N e —
e e o
rE¥ r r rF
At_. - ma Swa-ru- - pa-ka Ling-am—_ Ling.- am
| I | I
— ' — ' s
? g o 2 ! —
I ! I r r I [' ¥
| \ A A 2 .
] e =
o - Ve Py
1 Py I b a a
3 ¥ ﬁr r r 3 1 © &
Ma- ha Sa_ - i— Shi-va Ling.- am_—______ Ling. - am

BT

= : E

TN

Glory to the wonderous L.ingam,
The form of the Divine Atma,
The great Sai Shiva Lingam.

LINGAM: The form of God. As in the Shivalingam, the merging of
the form with the formless. Because of the oval shape, there is
no beginning or ending, so it merges with the formless. That in
which this jagath (universe) attains laya (the merging of the
sensory or finite mind in the infinite); symbolizes the goal of
life; 'a symbol’; the symbol of creation.
- -TRANSLATIONS BY BABA (Youngs) p. 83.
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ALAKNIRANJANA

Melody and text provided by Edith Bischel and the Arizona devotees.
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Sathya Sai Maragan.
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Melody and text provided by Edith Bischel and the Arizona devotees.
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Imperceptible, faultless Lord,
Destroyer of the fears of worldly existence,
Sathya Sai Narayan.
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Sing the praise of Allah and Lord Sai,

Sing the glory of Lord Rama and Lord Krishna,
Sing in worship of Guru Nanak and Lord Buddha,
Sing the glory of Jesus, Zoroaster and Mahavira,
Sing in praise of Shirdi Sai Baba who is Lord,
Sing the glory of Sathya Sai Baba who is Lord.

ALLAH - The supreme, formless God of the Islamic faith.
BHAJO - Sing in worship. MOULA - Islamic word for saint.
SAI - Sai Baba. PRABHU - Lord. NATHA - Lord
RAMA - Incarnation of God during the Treta age.
KRISHNA - Incarnation of God during the Dwapara age.
NANAK - Guru Nanak, founder of the Sikh religion. ISHU- Jesus.
GAUTAM BUDDHA - Founder of the Buddhist religion,
literally means "enlightened one''.
ZORASTRA - Zoroaster, the founder of the Zoroastrian religion.
MAHAVIRA - Founder of the Jain religion
SHIRDI - Village where Sai Baba lived in his previous incarnation.
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Melody transcribed as sung by Baba's college boys (pre-1985).
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Melody transcribed as sung by Baba's college boys (pre-1985).
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ALLAH ISWARA TU

Melody transcribed from the soundtrack of the Bock film:
BHAGAVAN SRI SATHYA SAI BABA: THE UNIVERSAL TEACHER (PART lIl).

O Lord Sai!
Thou represent all: Allah, Iswara, Christ, Buddha,
Zorastra, Mahavir, Rama, and Krishna.
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ALLAH ISWARA TU

Melody transcribed from the soundtrack of the Bock film:
BHAGAVAN SRI SATHYA SAI BABA: THE UNIVERSAL TEACHER (PART IIl).

O Lord Sai!
Thou represent all: Allah, Iswara, Christ, Buddha,
Zorastra, Mahavir, Rama, and Krishna.

Bm F#m Bm
N ¥ A Repeat twice
\J IHJ.I. Py Py |
{~— F F £ @ ' ©
ANSVJ 1 1 1 1]
) } } , %
Al_ - lah_ I_- swa- ra Tu
F#m Bm F#m Em Em
N # A 1 e, 2 pe—
g &L 1 | N 1 I 1 1 I 1
i | " — e  pev” s —
ANV 1 1/ 1 1/ el [*2
) I r [ Y
E_.- su Bud_ - dha Pra-bhu Tu Tu
F#m Em Bm Bm
N # N | | — 1 2
\J wl | N ™ 1 1 | I |
y A | 11 1 1 | I— |
[ [am) il / ‘ 1 1 -
ANSVJ &, (9]
)
Zo - ra stra_ Ma.- ha_- vir—_ Tu Tu
Bm Em Cfm7bs F4 Bm F4
N _#
g # 1 A 1 I | I
(Sl N— P— i N !i dl" il
ANSV4 1 / o Py P~ | ]
.) _J_ J - - - _‘. J
Sa_ - i Ra_- ma Tu__ Sa_- i Krish_- na Tu__
Bm Em F#m Bm
N # A
: E# g % |A) —
ANV 1 "4 1 1/ 1] —
o } } | ¥ %
Sar_- va Dhar_- ma Pra-bhu Tu
Bm F#m Bm
N # A
\J INJ.I. P P I\,
fr~—t - - g @ ¥ ©
ANV 1 1 1 1]
Q) T T I y
Al_- lah_ I_- swa - ra Tu
Bm Em F#m Bm
A 4 N Repeat twice
\J Wi Py Py |A)
y Y d | = F P R / Py
N\ il 1 1] )
ANSV4 1 "4 1 1/ 1]
) } } , r—V
Sath_- ya Sa_ - i Pra-bhu Tu

Copyright - All Rights Reserved. Permission Granted for Non-Commercial Use for the Purpose of Photo-

copying the Music for Personal or Group Devotional Singing. Recording Rights or Mass Redistribution

Rights are Not Granted for Commercial or Non-Commercial Use. Contact the Owner of the Copyright for
Permission. The Web Site Will Not Grant Permission for Any Other Use Held by the Owner of the

Copyright.




ALLAH TUMAHO ISHWARA TOMAHO (page 1)

Melody transcribed from the recording: SATHYA SAlI COLLEGE BOYS SING BHAJANS

(Brindavan 12/79).
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You are the Lord of
all religions. My Lord.
My Lord Raheem,
with love you come.
Give us Your blessing
and and protect us.
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ALLAH TUMAHO

ISHWARA TOMAHO

Melody and text transcribed from the recording
SATHYA SAI COLLEGE BOYS SING BHAJANS (Brindavan 12/79)
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AMBA BHAVANI SHIVA SHAMBHO KUMARA

Melody transcribed from the recording: SATHYA SAI COLLEGE BOYS SING BHAJANS
(Brindavan 12/79).

Repeat twice

Amba name of Parvathi, the Divine Mother.
Bhavani name of Parvathi, means Savior
from the cycle of birth and death.
Shambho name of Shiva,
means Bestower of Good.
Kumara son.
Sri title denoting honor or sacredness.
Ganatha name of Ganesha, means

Lord of the Ganas, the troups of demi-gods.
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Shanta peace.
Kara give, bestow.
Purana Purusha the Primal Person.
Natha Lord.
Pranava Om, the sound of
the supreme universal reality.
Swarupa form, reality.
Parthisha Lord of (Putta-) Parthi.

Beloved son of Shiva Parvathi,
O Lord Ganesha, Lord of the Ganas,
Giver of Peace, Primal Indweller, Sathya Sai Lord,
You are the form of Om, Lord of (Putta)Parthi.

"Truth is the all protecting God; there is no mightier guardian than Truth."
Bhagavan Sri Sathya Sai Baba
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AMBA BHAVANI SHIVA SHAMBHO KUMARA

Melody transcribed from the recording: SATHYA SAlI COLLEGE BOYS SING BHAJANS
(Brindavan 12/79).

Repeat twice

Shanta peace.
Kara give, bestow.

Amba name of Parvathi, the Divine Mother.
Bhavani name of Parvathi, means Savior
from the cycle of birth and death.
Shambho name of Shiva,
means Bestower of Good.
Kumara son.
Sri title denoting honor or sacredness.
Ganatha name of Ganesha, means
Lord of the Ganas, the troups of demi-gods.

Natha Lord.
Pranava Om, the sound of

the supreme universal reality.
Swarupa form, reality.

Beloved son of Shiva Parvathi,
O Lord Ganesha, Lord of the Ganas,
Giver of Peace,
Primal indweller, Sathya Sai Lord,
You are the form of Om,
Lord of (Putta)Parthi.

"Truth is the all protecting God; there is no mightier guardian than Truth.
Bhagavan Sri Sathya Sai Baba

Copyright - All Rights Reserved. Permission Granted for Non-Commercial Use for the Purpose of Photo-
copying the Music for Personal or Group Devotional Singing. Recording Rights or Mass Redistribution
Rights are Not Granted for Commercial or Non-Commercial Use. Contact the Owner of the Copyright for
Permission. The Web Site Will Not Grant Permission for Any Other Use Held by the Owner of the
Copyright.

Am Em Am F Dm Em7
[a) | A, [—
N Y Y Y ' B 3 '
@ 7 ? ! s s » » | —
) [
Am - ba Bha-va - ni Shi-va Sham_- bho Ku- ma_ - ra_
A Am Bm7 Am Em Dm Dm7 Am Repeat twice
| A
g | 3 IAY |
Gl= =S== =——
) — @ u‘
Sri__ Ga-na - na—_ - tha__ Shan___- ta__ Ka_ - ra_
Repeat twice
A E B7 E E7 Am Dm7 E7 Am
A |
g IAY R |
7 —® \ \ ® [ — # ] £ ut »
ANV | ] 1] 1] | 1] 1L/ | |
D)) I 4 4 4 I 4 r —
Pu-ra - na Pu-ru-sha_ Sath - ya Sa - i Na_ - tha_
Em Am Dm Em G7 Am Re i
Y peat twice
=D | | ———
N 14 @ O
S s S
Pra-na-va Swa-ru_ - pa— Par_ - thi_ - sha

Purana Purusha the Primal Person.

Parthisha Lord of (Putta-) Parthi.




AMBIKA TANAYA GAJANANA

Melody transcribed as sung by Baba's college boys (pre-1985).
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O Darling Son of Mother Ambika (Parvati)
Elephant faced Lord Gajanana (Lord of Minor Gods)
Kindly protect me. Ruler of the three worlds. Granter
of auspiciousness, Bestower of knowledge, Wisdom and power.
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AMBIKA TANAYA GAJANANA

.1
Kehy of C Melody transcribed as sung by Baba's college boys (pre-1985). P
P’ AN )
RGEAL e : > —
- . @ . & e o ? — F
< i i r
Am_ - bi-ka Ta-na-ya Ga-ja - na - na
YY)

o), . o
I3l : . ;
o L4 - —

=l ) —
b’ A N N A A \
(et R——— B — —
9 Ga-ja-va - da - na Ga-na Na - tha Ga - ja - na-na
A A\
D [ = .
r
°fn ‘
)’ A | \
Glir—— 1+ . FE 2
o s = =z 3 E < s s -
Sa -i Ga - ne - sha = Vi-na - ya - ka
. N N
3 I ; —3 |
2 F 7
13p
D’ A
o IS K N I—
KV ] ) L\ L\ — — \’ — ] a [
o e o o o o L i - — .
P Fo - Fr r F
Am_ - bi-ka Ta-na-ya Ga-ja - na - na
*): ®
L \, ‘ ‘
& d A
17h A A
A i . . } N—N Y B A N ‘ Y Y
r\wm / }(/ )‘) ‘R\, l‘\\, j j ] i ] [ ! = !
D $ ¢ 5 3 —s o % r 07
Tri-bhu-va - na Pa - la-ka Man-ga - la Da - ya-ka
A
'/': N ) 3 ] —) ihj e \
] 4 / / 1) [ / /
4 4 % r—r




AMBIKA TANAYA GAJANANA p. 2
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O Darling Son of Mother Ambika (Parvati)
Elephant faced Lord Gajanana (Lord of Minor Gods)

Kindly protect me.
Ruler of the three worlds.
Granter of auspiciousness,
Bestower of knowledge,
Wisdom and power.
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AMBIKA TANAYA GAJANANA

Key of F Melody transcribed as sung by Baba's college boys (pre-1985).
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O Darling Son of Mother Ambika (Parvati)
Elephant faced Lord Gajanana (Lord of Minor Gods)
Kindly protect me. Ruler of the three worlds. Granter
of auspiciousness, Bestower of knowledge, Wisdom and power.
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Key of F Melody transcribed as sung by Baba's college boys (pre-1985). p.1
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O Darling Son of Mother Ambika (Parvati)
Elephant faced Lord Gajanana (Lord of Minor Gods)
Kindly protect me.

Ruler of the three worlds.

Granter of auspiciousness,

Bestower of knowledge,

Wisdom and power.
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ANTAR JYOTHI NAMO
(BOW TO THE LIGHT WITHIN)
Melody transcribed from the recording: LEARNING BHAJANS.
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ANTAR - inner
JYOTHI - Light
NAMO - bow to

PARAMATMA -
the Supreme
Soul

AKHANDA -
endless

MAMA - my

JIVANA - life

ANTARYAMI -
the Inner God
residing in
all beings

SADGURU -
the true,
good
Teacher



ANTAR JYOTHI NAMO

(BOW TO THE LIGHT WITHIN)

Melody transcribed from the recording: LEARNING BHAJANS.
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An.- tar__ Jyo_ - thi Na - mo Pa-ram -
Bow_ to the lightt with_ - in, to the
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A- khan_- da Jyo_- thi Na - mo Ma- ma
Bow to__ the end.- less__ light, the___
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Jee_ - va - na Jyo_- thi Na - mo
light _ that is my__ ver-y life
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An_- tar_- ya_- mi Na - mo Jai
Bow_ to the in_- dwell-ing Lord, our
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Sad_- gu-ru Sa_—_- i Na- mo
true_ Gu-ru Sri_ Sath-ya Sa_ - I

ANTAR - inner
JYOTHI - Light
NAMO - bow to

PARAMATMA -
the Supreme
Soul

AKHANDA -
endless

MAMA - my

JIVANA - life

ANTARYAMI -
the Inner God
residing in
all beings

SADGURU -
the true,
good
Teacher
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(COME SAI, LORD INCARNATE)

Melody and text provided by the devotees of the Phoenix, Arizona Sai Center.
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A-0 Sa-i Na-ra-ya-na dar—- sha- na dee_.- jo,
Come~ Sa -1, Lord In-car-nate give—_ wus Your Dar.- shan.__
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Tu- mi—- ho Ja - ga - da - bhi Dha_—_ - ta,
You are the Lord__ of <cre - a_ - tion.
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Tu - mi— - ho Ja - ga - da - bhi Dha—_ - ta.
You are___ the Lord of cre - a__ - tion.
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Tu-mi_—- ho Ra__- ma__ Tu-mi_- ho Krish__—- na,__
You are__ that Ra_- ma,_—_ You are__ that Krish_- na___
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Tu - mi— - ho Vi_- shwa Vi - dha_ - ta,
You are our Lord_ and Pro - vid_—_- er,
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(COME SAI, LORD INCARNATE)
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Tu - Mmi— - ho Vi - shwa Vi - dha_— - ta.
You are__ our Lord_ and Pro - vid__ - er.
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Tu-mi_- ho Brah_- ma__ Tu- mi_- ho Vish_- nu,__
You are___ Cre - a_— - tor,— You are__ Pro-tec_—_- tor.—
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Tu - mi_- ho Shan_- ka - ra Ru_- pa,
You are_ De - stroy__- er of dark. - ness.
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Tu- mi—- ho Shan_- ka- ra Ru - pa.
You are__ De-stroy_- er of dark - ness.
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AO SAI NARAYANA DARASHANA DEEJO

(COME SAIl, LORD INCARNATE)

Melody and text provided by the devotees of the Phoenix, Arizona Sai Center.

Eb Bb7 Eb Gm cm Bb7 Eb
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A-0 Sa-i Na-ra-ya-na Dar—- sha-na Dee_- jo,
Come_ Sa - i, Lord In- car-nate give__ us Your Dar.- shan._
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Tu- mi—- ho Ja - ga - da - bhi Dha_ - ta,
You are the Lord__ of <cre - a_ - tion.
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Tu - mi— - ho Ja - ga - da - bhi Dha__—_ - ta.
You are__ the Lord of cre - a__ - tion.
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Tu-mi_—- ho Ra__- ma__ Tu-mi_- ho Krish__—- na,__
You are__ that Ra_- ma,__ You are__ that Krish_- na__
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Tu - mi— - ho Vi_- shwa Vi - dha_ - ta,
You are our Lord_ and Pro - vid_- er,
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Tu - mi— - ho Vi_ shwa Vi - dha__— - ta.
You are__ our Lord_ and Pro - vid__ - er.
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Tu-mi_—- ho Brah_- ma__ Tu- mi_- ho Vish__- nu,__
You are Cre - a_ - tor,__ You are__ Pro- tec__- tor.__
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O I !}u i | s I I
g H | Py F Py 1 |A) N 1 1
R I — —s 1 2
o |4 I |4 -
Tu - mi_- ho Shan_- ka - ra Ru_- pa,
You are_ De - stroy__- er of dark. - ness
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Tu- mi—_- ho Shan_- ka- ra Ru - pa.
You are__ De-stroy_- er of dark - ness.
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The melody transcribed from the soundtrack of the film: SATHYA SAI BABA'S 60TH BIRTHDAY
CELEBRATION (Part 2)The English text authored by Richard Del Maestro, California, USA.

O ﬁu ) I I f I | N IL\I I I‘\ | I ]
o - ———— ! =a=mtmte ms e is !
A8V S 3 1 ! 1 T i 7 1 ]
¢ 5 3 3 33 3 T ¢ < ’ “
1. Om Jai Ja-ga-di - ha Ha - re, Swa- mi Sath-ya Sa_ - i Ha- re_
1. Om, Lord of Cre-a - tion we praise Swa- mi Sath-ya Sa_ - i Ha - re_
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Bhak_ - tha Ja - na Sam - rak_- sha-ka Bhak. - tha Ja - na Sam - rak_ - sha- ka
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Par - thi Mah - e___- shwa - ra Om Jai Ja-ga - di—- sha Ha - re.
Par - thi Di - vine__ Lord God Om, Lord of Cre - a_- tion we praise.
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2. Sha - shi - va-da - na hr\i'/_ - ka- ra Sar—_- va_ Pra_ - na-pa - te, Swa- mi
2. Moon- light rays of love, fall on us, We_ are_ breath-ing inYour Grace, Swa-mi,
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Kal - pa-la - ti- - ka A - ad - ban— - dha - va. Om Jai Ja- ga -
Love we sur - ren— - der Friend of those— in need om, Lord of Cre -
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Man_ - ga- la A - ra - thi An_ - du-ko, Man - da- ra Gi- - ri- dha - ri. Om
Please_ fill our hearts with Your light and love._ Lift and pro - tect Your de- vo- tees Oom,
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Jai Ja-ga - di—- - sha Ha - re. 5. Na-ra- ya-na, Na-ra-ya-na, Om Sath-ya,
Lord of Cre - a_ - tion we praise.
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Arathi is literally the worship of God with the flame of camphor.
The camphor burns and leaves no residue. Similarly, the flame
of the Love of God must consume the ego, leaving no trace of 'I'
and 'mine’. The flame represents the burning of all desires,
leaving no residues for merging with God.
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The Melody transcribed from the soundtrack of the film: SATHYA SAI BABA'S 60TH BIRTHDAY
CELEBRATION (Part 2). The English text authored by Richard Del Maestro, California, USA
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1. Om Jai Ja-ga-di - sha Ha- re, Swa-mi Sath-ya Sa_ - i Ha- re_—
1. Om, Lord of Cre-a - tionwe praise Swa-mi Sath-ya Sa_ - i Ha- re_
" Bb Fm  Bb7 Eb Bb Fm  Bp7 Eb
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Bhak_ - tha Ja - na Sam - rak_- sha-ka Bhak_- tha Ja - na Sam - rak_- sha-ka
Faith_. - ful de - vo - tees pro— - tec-tor, Faith_- ful de - vo - tees pro_ - tec-tor,
A | M Bb7 Eb cm Ab Fm  Fm7 Bb7 eb
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Par - thiMah - e.- shwa_- ra Om Jai Ja-ga - di- - sha Ha - re.
Par - thi Di- vine. Lord— God Om, Lord of Cre - a_ - tion we praise—
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2.Sha- shi - va-da - na shri - ka- ra Sar— - va_ Pra— - na- pa -
2.Moon-light rays of love, fall on us, We_ are— breath-ing in Your
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te, Swa-mi Sar - va Pra_ - na-pa - te__ Ash_- ri-ta Kal - pa-la-
Grace, Swa-mi, we are breathing in Your Grace._ Giv—_- er of Love we sur -
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ti - ka Ash_ - ri - ta Kal - pa-la - ti— - ka A - pad -
ren—- der, Giv— - er of Love we sur - ren— - der, Friend of
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ban_- dha_- - va. Om Jai Ja-ga - di- - sha Ha - re.
those_ In_ need. Om, Lord of Cre - a_ - tion we praise.
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us Swa-mi, You_ are ev - 'ry-thing to us._ God- of Sound_— that made cre -
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dra. Sha-ya - na Om Jai Ja-ga - di- - sha Ha - re.
cline— at the source Om, Lord of Cre - a- - tion we praise.
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4. 0m - ka- ra Ru - pa O - ja - swi Om Sa_ - i Ma - ha- - de— -
4. Om is Your form, God of Splen - dour, O Sa_ - i Ma - ha_ - de_ -
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va Sath-ya Sa - i Ma - ha. - de_ - wva__ Man_- ga- la A - ra- thi
va, Sath-ya Sa - i Ma - ha_ - de_ - va.__ Please_ fill our hearts with Your
, , 67 cm Fm  Fm7 Bb7 G7 cm Fm Bb7
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An_ - du- ko, Man_- ga - la A - ra - thi An_ - du- ko, Man - da- ra
light and love— Please_ fill our hearts with Your light and love._ Lift and pro -
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Gi— - ri- dha - ri. Om Jai Ja-ga - di- - sha Ha - re.
tect Your de-vo- tees Om, Lord of Cre - a_ - tion we praise__
verse 5 sung three times: SLOW, MODERATE, FAST.
n | Eb cm Bb Fm Eb
g T N N N N 3 N N I | N A | ‘I\ | N I‘\ A
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Na - ra- ya- na OoOm__—_ Na - ra - ya- na, Na - ra- ya- na, Om_ Sath- ya,
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Na - ra - ya- na, Na-ra- ya- na, Om_ Sath-ya, Na - ra - ya- na, Na - ra - ya- na
" Ab Fm Fm7 Bb Bb7 Eb D.S. al Coda
7T T T T N ——— ; ; M Arathi is literally the worship of
@ P i il il | ——T— ’i ’i ] God with the flame of camphor.
Py & #—‘vi The camphor burns and leaves no
Oom Om Jai Sad - gu-ru De_ - va. residue. Similarly, the flame of
[sung slower] the Love of Go_d must consume
Co%a eb Eb Db eb Bbm cm Db eb the ego, leaving no trace of 'I
| and 'mine'. The flame represents
A ';V,"i f » R K R » it i i m the burning of all desires, leaving
D—— 7 s 7 " % 7 P > P = no residues for merging with God.
D) - 4 - e
Oom, Shan - thi, Shan - thi, Shan- thi_—__
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ATMA RAMA ANANTA NAMA

Melody transcribed from the recording: LEARNING BHAJANS.

and have assumed the illusive form of

Let us adore

Rama whose name is

happiness...who is beautiful, blissful,
Infinite Love.
You are the embodiment of virtues,

the human being through Maya and
your love for mankind.
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ATMA RAMA ANANTA NAMA

Melody transcribed from the recording: LEARNING BHAJANS.
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Let us adore Rama whose name is happiness...who
is beautiful, blissful, Infinite Love. You are the
embodiment of virtues, and have assumed the

illusive form of the human being through Maya,

and your love for mankind.
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ATMABHI RAMA ANANDA NAMA

Melody transcribed from recording: LEARNING BHAJANS.
3
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O Lord Rama, You are the Blissful Indweller of our hearts.
O Lord Ghanshyam, O Lord of Radha, O Lord Sai Ram,

It gives happiness to recite your noble names.
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ATMABHI RAMA ANANDA NAMA

Melody transcribed from recording: LEARNING BHAJANS.
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E Am Am B7 Am B7
IR A
\g wlT o 1\ | | I
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O Lord Rama, You are the Blissful
Indweller of our hearts.
O Lord Ghanshyam, O Lord of Radha,
O Lord Sai Ram,
It gives happiness to recite your
noble names.
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AVO PRABHU AVO SAI BHAGAVAN

Melody and text transcribed from a recording: 108 NAMES OF GOD AND BHAJANS.
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AVO PRABHU AVO SAI BHAGAVAN

Melody and text transcribed from a recording: 108 NAMES OF GOD AND BHAJANS.
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AYODYA VASI RAM RAM RAM

Transcribed from the soundtrack of the film: SATHYA SAI BABA: THE EARLY YEARS.
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AYODYA VASI RAM RAM RAM

Transcribed from the soundtrack of the film: SATHYA SAI BABA: THE EARLY YEARS.
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Lord Ram, who resides at Ayodya,

darling son of Dasharatha,

You are the Savior of the fallen and helpless.

the Life of Janaki (Sita),

who capitivates the hearts of all.
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AYODHYAVAS| RAM RAM RAM (2nd Version)

Melody transcribed as sung by the Sundaram Bhajan Group, Madras, India.

Key of A-flat
y Ab D Ab
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Pa-ti- ta Pa.- va-na Ja-na- ki Jee.- va-na Si-ta— Mo-- hana Ram
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Pa-ti- ta Pa_- va-na Ja-na-ki Jee_- va-na Si-ta_ Mo.- hana Ram

Coda (Sing the Coda only after singing through the Bhajan a second time.)
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Pa-ti- ta Pa.- va-na Ja-na- ki Jee.- va-na Si-ta_ Mo_- hana Ram
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AYODHYAVASI RAM RAM RAM (2nd Version)
Key of A-flat Melody transcribed as sung by the Sundaram Bhajan Group, Madras, India.
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Pa-ti- ta Pa.- va-na Ja-na- ki Jee.- va-na Si-ta_ Mo_- hana Ram
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Coda (Sing the Coda only after singing through the Bhajan a second time.)
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Coda (sing the Coda only after singing through the Bhajan a second time.)
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